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1 Information About Using the Operating Instructions 
 
Keep these operating instructions so you can refer to them at a later date! 
 
 
1.1 Technical Terms 
 
You will find an explanation of all the technical terms used in these operating instructions in the Glossar section. 
 
 
1.2 Formatting Conventions 
 

• Terms used by the WirelessProfessional software and which you may encounter on the display are printed in bold in the 
instructions. For example, "Above the General view, you will find the General, Alarm List, Groups and Maps tabs". 

• WirelessProfessional software buttons appear with a grey background in the instructions. For example, "Select Login and 
enter the installer password." 

  
 
1.3 Basic Use of the WirelessProfessional Software 
 
The WirelessProfessional software can be used both via a touchpad / mouse or a touch screen. 
 
 

1.3.1 Tabs and Views 
 
Figure 1 shows an example of the Generalview used in the WirelessProfessional software. Above the General view, you will find 

the General, Alarm List, Groups and Maps tabs. A view is selected by left-clicking on the corresponding tab above the view or 
tapping the tab on the touch screen. 
 

 

 

  

Figure 1: General view 
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1.3.2 Highlighting 
 
An individual element in a list of elements is highlighted by left-clicking on the element or tapping the element on the touch screen 
(Figure 2). 
 
 

 

 
 
Several elements in a list can be highlighted by pressing and holding the Ctrl key and left-clicking on all the elements you want to 
highlight or tapping them on the touch screen (Figure 3). Alternatively, several elements can be highlighted if the multiple selection 

button  is clicked on or tapped first. If the multiple selection function is enabled, the  button comes into play and the 
part of the window for which the function is enabled is framed with a dotted line (see Figure 3: Selecting several devices)  

Figure 2: One highlighted device 
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The multiple selection button can be found in the top right of all lists in which several elements can be selected at the same time. 
If a tab contains several lists for which multiple selection is available, the multiple selection function can only ever be enabled for 
one list at a time.  
If the multiple selection function is enabled for a list in a tab with several lists offering the multiple selection function and the 
multiple selection button in another list is clicked on or tapped, the previously enabled multiple selection function is disabled.  
When a tab is exited, the multiple selection function is always automatically disabled.  
 
To cancel the multiple selection of elements, disable the multiple selection function and click on or tap an individual element. 
Alternatively, all highlighted elements can be tapped or clicked on again with the multiple selection function enabled. 
The highlighting and/or selection or multiple selection is retained when the tab is exited or when elements are highlighted in an-
other list under the tab.  
 
Several consecutive elements in a list are highlighted by clicking on the top element of the range to be highlighted or tapping this 
on the touch screen, then pressing and holding the Shift key and clicking on the bottom element of the range to be highlighted or 
tapping this on the touch screen (Figure 4). 
All elements in a list are highlighted by left-clicking on the list or tapping the list on the touch screen and then pressing Ctrl+A. 
Not all views in the WirelessProfessional software support all these methods for highlighting elements. 
 

Figure 3: Selecting several devices 
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1.3.3 Dragging 
 
Highlighted elements are moved by left-clicking on the highlighted elements and holding down the mouse button. The elements 
are then dragged to the desired location (Figure 5) and the mouse button is released. 
On the touch screen, highlighted elements are moved by touching the highlighted elements with your finger, keeping your finger 
on the elements and dragging them to the desired location (Figure 5). Once in the desired location, lift your finger off the touch 
screen. Alternatively, the highlighted elements can be moved with the aid of the context menu. See 1.3.4 Context Menu. 
 

 

 

Figure 4: Several consecutive highlighted devices 

 

Figure 5: Dragging several highlighted elements 
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1.3.4 Context Menu 
 

The context menu for one or more elements is opened by clicking on or tapping the context menu button  (Figure 6). The 
right-click option previously used is no longer available. The context menu button can be found in the top right of each window for 
which there is a context menu available. 
 

 

 Figure 6: Context menu for a device 
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2 Introduction to the WirelessProfessional System 
 
The WirelessProfessional system is a system for automatically testing safety lighting in accordance with DIN EN 62034. 
Figure 7 shows the components of a WirelessProfessional system and how they work. The emergency luminaires and other devices 
form a radio network, via which they communicate with the automatic test system. The automatic test system comprises a PC with 
the WirelessProfessional software (Figure 7 no. 4) and USB coordinator (Figure 7 no. 3). The USB coordinator establishes the con-
nection between PC and radio network. The frequency of the radio network is 868 MHz. 
 

 
 
 

 

 
 
Each device in the radio network has a send/receive radius (Figure 7 no. 1). The send/receive radius of the WirelessProfessional 
device is at least 30m indoors.  
 
For it to be possible to pass data between two devices in the radio network, the one device must be in the send/receive radius of 
the other one. All the devices in a system must be linked to the USB coordinator of the automatic test system through an uninter-
rupted chain of devices, which are able to pass on data. Figure 8 shows a system, in which the radio connection to the three devices 
in the top right is interrupted. All other devices in the Figure are linked to the USB coordinator through an uninterrupted chain of 
devices and can communicate with it. 
 
 

1 Send/receive radius 
2 Maintained emergency luminaire 
3 USB coordinator 
4 Computer 
5 Repeater 
6 IO box 
 

Figure 7: Setup of a WirelessProfessional system 

1 2 3 4 5 6 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 

Page 7  

 
 

 
Tabelle 1 lists the device types available to the WirelessProfessional systems and their functions. Only the device types stated for 
WirelessProfessional systems may be used in WirelessProfessional systems. 
 

Device type Function 
Maintained emergency luminaire Luminaire for continuous lighting and for instances when the power supply to the 

general-purpose lighting fails 
Non-maintained emergency luminaire Luminaire for instances when the power supply to the general-purpose lighting 

fails 
IO box Device with digital inputs/outputs for issuing system statuses and triggering sys-

tem functions externally 
Repeater Device for bridging the gap between two devices in the radio network if they are 

outside the send/receive radius 
 
Table 1: Device types of the WirelessProfessional system 
 
 
Each WirelessProfessional device has its own four-digit, alphanumerical address. The address can be found on the outside of the 
WirelessProfessional devices. In the WirelessProfessional software, devices are identified and assigned to the right mounting loca-
tion by means of their address. A WirelessProfessional system may comprise no more than 1000 devices. A larger number of 
devices can be split over several WirelessProfessional systems. 
 

2.1 Commissioning after Power Supply has Failed 
 
Should the power supply fail, the emergency lighting goes into emergency mode. Once the power supply has been restored, the 
PC has to be switched on again using the On/Off switch in order for the automatic test system to start up. The Windows user 
account is logged into automatically and the WirelessProfessional software is launched automatically. 
 
 
 
 
 
 
 
 
 
 
 

Figure 8: Devices with radio connection to the USB coordinator (green) and devices with interrupted radio connection (red) 
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2.2 Running Capacity Tests 
 
A capacity test of WirelessProfessional emergency luminaires can only be undertaken if the mains operation was last interrupted 
(mains failure, fuse failure, capacity test) at least 24h ago. 
When starting a capacity test, the WirelessProfessional system produces a schedule for starting the test on each emergency lumi-
naire. Using this schedule, the capacity test is first started on the emergency luminaires with the longest autonomy time. If all 
emergency luminaires on the WirelessProfessional system have the same autonomy time, the test is started one after the other on 
each emergency luminaire. 
If a manual capacity test is started and the test cannot be started on one or more emergency luminaires, the launch of the capacity 
test for these emergency luminaires is postponed by 15 minutes and/or the WirelessProfessional software tries to start it again. 
The WirelessProfessional software will try up to ten times to run a capacity test for the emergency luminaires before an entry is 
made in the inspection log book stating that the capacity test has failed. 
 
Note: The time that the WirelessProfessional systems need to run a capacity test is more than the autonomy time of the emergency 
luminaires and increases in proportion to the size of the system. The end of the capacity test is also extended by 15 minutes each 
time the system tries to start the test.  

2.3 Processor-Controlled Emergency Luminaires 
 
In some WirelessProfessional emergency luminaires, battery charging is controlled by a microprocessor. This prevents function 
and capacity tests from being run if the battery has not been charged to the required end-of-charge voltage. Luminaires with this 
characteristic are described in the enclosed instructions as a “processor-controlled emergency light” or a luminaire with “integrated 
SelfControl monitoring”. 
 

2.4 Invalid Times due to Flat RTC Battery 
 
 
If the following error message appears when launching the Wireless Professional software, the system date is invalid and/or the 
real time clock battery is flat and needs replacing. 

 
 

 
Figure 9: Error message indicating invalid system date 

 

2.5 Protection Against Unauthorised Access 
 
The active system can be protected from unauthorised access by activating full-screen mode. The password for the relevant user 
level will have to be entered to exit full-screen mode. 
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3 Installation 
3.1 Before Commissioning the Automatic Test System 
 
Before you commission the automatic test system, the emergency luminaires and other devices should have been fitted in the 
building and their addresses entered in the map. The 3rd address sticker, included in the scope of supply for each device, can be 
used for this purpose. All emergency luminaires and other devices, which are to be added to the safety lighting system during the 
installation process, must be in mains operation. 
DIN EN 62034 requires a capacity test over the entire assessment period when commissioning an automatic test system. The 
batteries of the emergency luminaires must be fully charged (at least 20 h) for this capacity test. Ensure that all emergency lumi-
naires have been in mains operation for a period of at least 24 h without any interruptions before starting the initial capacity test 
on the automatic test system. 
 

3.2 Using the WirelessProfessional Software 
 
If you are not yet familiar with how to use the WirelessProfessional software, it is essential that you read Section 1.3 about basic 
use of the software before you start the commissioning process! 
 

3.3 Connecting PC and USB Coordinator 
 

• Connect the PC power supply to a socket and connect the PC to the power supply. 
• Connect the USB coordinator to a free USB port on the PC. 
• Important: Use the USB cable provided to connect the USB coordinator to the PC. Always connect the USB coordinator 

to the PC directly and not via a USB hub. 
• Boot up the PC with the On/Off switch. 

 
The operating system launches automatically with the WirelessProfessional user account and the WirelessProfessional software is 
launched automatically. The connection to the USB coordinator is established automatically and the display in the application 
window’s title bar changes from [not connected] to [connected and running]. If the connection to the USB coordinator is 
not established automatically, change the port manually as described below. 
 
In the top left edge of the screen, click on Options and then Serial Port or click on the Installation tab and then System. This 
allows you to click on the Serial Port button and go to the drop-down menu for the serial port. 
 

Figure 10: Serial Port drop-down menu accessed from Options 

 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 10  

In the next window, click on the black arrow to open the drop-down menu, select USB Serial Port and confirm with OK. The 
application window’s title bar should then have changed to [connected and running].  
 
Note: The COMx details depend on the USB slot selected and so may vary. 
 

 
Figure 11: Selecting serial port 
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3.4 Changing Password 
 

• Select Login and enter the Installer password. The installer password is preset in the factory to 2222. 
• Go to the Installation tab. Select the System tab from the bottom set of tabs. Select Change Installer Password. 

 
 

 
Figure 12: Changing password 

 
• Enter the preset installer password. Enter a new password and re-enter it. Take a note of the new password. 

 

 
Figure 13: Entering password 

 
 

3.5 Entering Contact Details and System Names 
 

• Enter your contact details in the First Name, Last Name, Company, Phone and Email boxes. 
• Enter a name in the System name box. 
• Confirm the entries by clicking on Save System Data. 
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3.6 Installing Devices in the System 
 

• Select Installation and Configure Groups. The Unknown nodes area shows the emergency luminaires and additional 
devices, which have a radio connection and which are not yet installed in a system. Ensure that all emergency luminaires 
and additional devices which have been fitted are powered by the mains and wait until all devices are listed in the Un-
known nodes area. 

 

•  
Figure 14: Devices available 

 
Note: A different process is used to register devices with a wireless module of version 2.0 or higher. If not all devices are displayed 
in Unknown nodes, use the Find New Devices… button to start a new search. 
 
 

 
Figure 15: Searching for new devices 

 
Confirm the notification by selecting Yes to search for new devices on your system. 
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• Now install all emergency luminaires and additional devices in the system. To do this, highlight all elements in the Un-
known nodes area and drag the highlighted elements into the Registered nodes area. 

 
Warning: During the installation, position the USB coordinator so that it has a direct radio connection with fewer than 50 
devices (for details, see Section 8.13). 

 
Figure 16: Highlighting devices available 

 
Note: If you do not want to install all elements from the Unknown nodes area: Press and hold the Ctrl key and highlight just 
those elements you want to add by clicking on the elements and dragging them into the Registered nodes area. 
 

• The WirelessProfessional software installs the added emergency luminaires and additional devices in the system. The 
remaining number of devices not yet installed is displayed in the first line of the Registered nodes area (x devices 
not associated). The time needed for this may vary depending on how the devices are arranged in the radio network 
and how far the installation has progressed (anything from several seconds to several minutes per luminaire). 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 14  

 

 
Figure 17: Associating devices available 

• Once all devices have been successfully installed in the system, the first line of the Registered nodes area shows the 
number of emergency luminaires, repeaters and IO boxes installed in the system. 

 

 
Figure 18: Devices successfully associated 
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• If you want to change the name of an installed device, open the device’s context menu in the Registered nodes view 

and select Rename 'NAME'. 
 

 
Figure 19: Renaming devices 

 
• If you want to switch the operating mode of an emergency luminaire between non-maintained and maintained operation, 

open the device detail window for the emergency luminaire in the Registered nodes area (also refer to Section 5.15.1) 
by double-clicking with the left-hand mouse button on the name of the emergency luminaire or tapping the name twice. 

• Complete installation of the devices in the system by selecting Save System Data. 
 

  



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 16  

3.7 Dividing Devices into Groups 
 
1. If you want to divide system devices into groups, open the system context menu (first line of Registered nodes area) and 

select Add Group to 'System'. 
 

 
Figure 20: Creating a group 

 

2. Enter the name of the group in the Add Group to '<System>' window and then select OK. 
 

 
Figure 21: Group name 

 
The newly added group is added to the list in the Registered nodes area in alphabetical order. Under some circumstances, it 
will therefore not be visible in the part of the list on display. 

 
3. Press and hold the Ctrl key and highlight all elements in the list that are to be added to the new group. Drag the highlighted 

elements to the new group. If the group is not visible in the part of the list currently on display, scroll through the part you can 
see until the new group appears by dragging the highlighted elements to the top or bottom edge of the Registered nodes 
area. 
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Figure 22: Assigning devices to groups 

 
4. Repeat steps 1-3 until all devices are divided into groups. 
5. Complete division of the devices into groups by selecting Save System Data.  
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3.8 Maps 
 
The WirelessProfessional software provides the option of integrating maps and positioning installed devices on them. The mount-
ing location of a device can therefore be found quickly when required. The maps must exist in .png, .bmp or .jpg format. The 
maximum size of the maps is 10 mega pixels. Larger maps cannot be loaded into the WirelessProfessional system. 
 
 

3.8.1 Integrating Maps 
 
1. Select the Maps tab. 

 
Figure 23: Maps in general 
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2. Open the context menu of the Maps in system area and select Add New Map. 
 

 
Figure 24: Adding new map 
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3. Go to the file dialogue for the data carrier on which the maps are located. Highlight the maps you want to add, and confirm 
the selection by clicking on Open. 

 

 
Figure 25: Selecting files 

 
4. Open the context menu of an added map and select Rename Map <Name>. 
 

 
Figure 26: Renaming map 

 
5. Enter a meaningful name for the map and confirm the entry by clicking on OK. 
6. Repeat steps 4 and 5 for all maps. 
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3.8.2 Positioning Devices on the Map 
 

• Select Toggle Map View. 
 

 
Figure 27: Toggling map view 

 
1. Select the map on which devices are to be positioned from the drop-down selection box. 

 

 
Figure 28: Selecting map  
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2. Use the slide control to adjust the scale and use the scrollbars below and to the right of the map to select the relevant image 
section. 

 

 
Figure 29: Scaling view 

 
3. Drag the devices from the left-hand area into the map and position them. 
 

 
Figure 30: Positioning devices 
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4. Repeat steps 1-3 until all devices are positioned on the maps. 
 

5. Complete positioning of the devices on the maps by selecting Save System Data. 
 
Note: Each emergency luminaire and/or each device can only be positioned once and only in one map. 
 
Note: We would recommend regularly saving your changes. 
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3.9 Setting up Automatic Test 
 

• Select the Installation tab. Select the Test tab from the bottom set of tabs. 
• In the Capacity test area in the drop-down Interval selection box, select the period between two automatic capacity 

tests for the emergency luminaires. DIN EN 62034 requires a maximum interval of one year between two automatic ca-
pacity tests. 

• Enter the time at which the capacity test is to start in the Time box. Select a time at which the building is not occupied. 
Alternatively, DIN EN 62034 allows the capacity test to be triggered manually in buildings which may be occupied at any 
time. In these cases, select Manually as the interval. 

• In the calendar in the Start datebox, select the date for the next capacity test. Select a date, which is no more than one 
year in the future. 

• In the Function test area, also select an interval and time for the automatic function test. DIN EN 62034 requires a maxi-
mum interval of one month between two automatic function tests. 

• If you have selected Weekly as the interval, in the drop-down Weekday selection box, select the day of the week on which the 
function test is to be carried out. 

• Complete the settings by clicking on Save System Data. 
• If necessary, please note other valid national provisions or other provisions required by building law relating to capacity 

and function tests. 
 

•  
Figure 31: Timer settings 

 
Note: If systems have more than 100 registered luminaires/devices, the function test command is only sent out for 100 luminaires 
at a time to minimise the amount of wireless traffic. The function test for the next 100 devices starts once the function test of the 
previous 100 devices is complete. 
 
Note: As explained in Section 2.2, capacity tests are started on the basis of a schedule. Unlike the explanation provided in Section 
2.2, the start of the test for an automatic capacity test is only postponed 3 times in every 24h. 
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3.10 Capacity Test during Commissioning 
 
DIN EN 62034 requires a capacity test over the entire assessment period when commissioning an automatic test system. The 
batteries of the emergency luminaires must be fully charged (at least 24h, see Section 2.2 and 2.3) for this capacity test. 
 

• Select the General tab 
• Press the Start Capacity Test button 

 
If the batteries of individual luminaires are exhausted before the capacity test is completed, repeat the process including a full 
charge (at least 24h). 
 
To complete commissioning, reset the maintenance interval by going to “Help” -> “Maintenance” and clicking on the “Confirm 
Maintenance” button. The reminder for running maintenance again will start from this time in 365 days. 
 
 

 
Figure 32: Starting capacity test 
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4 Software Installation 
 
This section relates to systems supplied without a PC. If systems have been supplied with a PC, the WirelessProfessional software 
will already be installed on the PC. 
 
 

4.1 System Requirements 
 

 
 

4.2 Installation 
 

• Open the context menu of the WirelessProfessional_Setup_x.x.exe file. (x.x represents the version number) and 
select Run as administrator. 

 

 
Figure 33: Selecting installation file 

  

Component Minimum requirement 
Processor Intel Atom N455 1.6 GHz 
RAM 1024 MB DDR3-RAM  
Hard disk 32 GB SSD 
Display 25.7 cm (10.1") screen size, resolution 1024x600 pixels 
Graphics Intel GMA 3150 
Ports 2 x USB 2.0 
Operating system Windows 7/8/10, 32- and 64-bit version 
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• Enter the administrator password in the dialogue box of the user account controller and confirm with Yes. 
 

 
Figure 34: Entering administrator password 

 

• Select the language to be used during the installation process. 
 

 
Figure 35: Selecting language 

 

• Select Next in the setup dialogue. 
 

 
Figure 36: Setup dialogue 

 

• Read the information provided about the installation directory and select Next. 
 

 
Figure 37: Setup dialogue 
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• Select a start menu folder for the program links and then select Next. 
 

 
Figure 38: Setup dialogue 

 

 
• Select whether a desktop symbol is to be created and then select Next. 

 

 
Figure 39: Setup dialogue 

 

 
• Select Install. The software and the drivers required are installed. 

 

Figure 40: Setup dialogue 
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• To complete the setup wizards, select Finish. The WirelessProfessional software is launched. 
 

 
Figure 41: Completing installation 

 

Note: The CPC Viewer and CPC File manager programs are needed if remote access to a remote system is to be set up.  
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5 Removing Devices from the WirelessProfessional System 
This section explains how devices are removed from the WirelessProfessional system.  
You must be logged in to the WirelessProfessional software as an installer in order to remove devices. Then go to the Installation 
tab and call up the installation view for the WirelessProfessional software. 
 
One or more devices or a group of devices can be removed from the system. Highlight the device or group by tapping on it. Once 
the selection has been made, use the context menu button to select the context menu and then select Delete Luminaire 
‘NAME’. Alternatively, the devices or groups can be dragged & dropped out of the Registered nodes area into the Unknown 
nodes area. 
 

 
Figure 42 Registered nodes context menu 

When devices are removed from the Registered nodes area, a specific de-association command is issued wirelessly for each 
device by the WirelessProfessional software. When the de-association command is received by the device, the system ID saved in 
the device is reset, meaning that the device is no longer part of the WirelessProfessional system. Resetting the system ID resets the 
device to the initial configuration. 
The address of the removed devices is shown in the Unknown nodes area.  
 
When removing devices, a distinction is made between whether the device can still be accessed using wireless technology or 
whether the wireless connection has been lost. 
 
Note: If a device is removed from the WirelessProfessional software, the test history for this device is closed. If the device is re-
assigned, the WirelessProfessional software starts a new test history for this device. Existing histories are not continued.   
 

5.1 Removing Devices that can be Accessed using Wireless Methods  
Once devices have been removed from the WirelessProfessional software as described above, the devices can be disconnected 
from the power supply. When the power supply is disconnected, devices with an emergency light function are powered from the 
battery. Disconnecting the battery from the electronics stops the emergency mode.  
 
Once the device has been fully de-energised for around 15 minutes, the device’s address disappears from the Unknown nodes 
area.  
 
This process should be used if devices are to be removed and reused. When the device is started up again, its address will be 
displayed in the Unknown nodes area in the WirelessProfessional software. 
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Note: The WirelessProfessional software sends a de-association command to the selected devices. The recipient does not confirm 
that this command has been received. The WirelessProfessional software therefore has no means of checking whether the com-
mand is received and processed in the devices.  
 
Note: De-associated devices start by issuing association requests. When removing several devices or when removing a group of 
luminaires, instances may therefore arise in which not all devices receive the de-association command.  
 

5.2 Removing Devices that cannot be Accessed using Wireless Methods 
If a device cannot be accessed using wireless methods and if it is removed from the WirelessProfessional software in this state, 
then the device does not receive the de-association command issued by the WirelessProfessional software. As a result, the device 
itself is still considered to be a node registered on the WirelessProfessional software.  
 
The process for removing devices that cannot be accessed using wireless methods should be used with defective devices, for 
example, because they are not typically started up again. 
 
When the device is started up again, its address will not be displayed in the Unknown nodes area in the WirelessProfessional 
software. 
 
Note: If this device is started up again within the wireless range of the WirelessProfessional system from which it was previously 
removed, this may produce incorrect status messages in the WirelessProfessional software and potentially result in devices behav-
ing incorrectly.   
 

5.3 Resetting the System ID of Previously Removed Devices at a Later Date 
If the system ID was not reset when removing the device from the WirelessProfessional software, there is a way of issuing a specific 
de-association command for the device wirelessly via the WirelessProfessional software.  
For the system ID reset in the device to work, the device must be connected to the power supply. The USB coordinator must also 
have wireless access to the device and the 4-digit device address must be known. 
You must be logged in to the WirelessProfessional software as an installer. Then go to the Installation tab and call up the instal-
lation view for the WirelessProfessional software. 
In the context menu in the Unknown nodes area, select Add New Luminaire. 
 

 
Figure 43 Unknown nodes context menu 
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A window entitled Address for the New Device opens. The device’s 4-digit address at which the system ID is to be reset is 
entered in the text box.  

 

 
Figure 44 Entering address for the new device 

 
 
Once the 4-digit device address has been entered, confirm by pressing the Delete button. The WirelessProfessional software now 
issues a specific de-association command to the device. During this process, the device is listed as TempNode[Address] in the 
Registered nodes area and removed again automatically once the process is complete. 
 
Note: If there is a lot of wireless traffic, you may need to press the Delete button several times. 
 
Close the Address for the New Device window by pressing the Close button. If the system ID reset was successful, the 4-
digit device address will appear in the Unknown nodes area. 
 
Note: If the window is closed using the OK button, the 4-digit device address is written to the Unknown nodes area. You can-
not then check whether the system ID has been reset successfully. 
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6 Masking Devices on the WirelessProfessional System  
This section explains how the function for masking devices on the WirelessProfessional system can be used.  
If a device is masked in the WirelessProfessional software, this means that pending error messages for this device are no longer 
displayed in the WirelessProfessional software. The masked device is not checked during the WirelessProfessional system’s func-
tion or capacity test.  
 
Masking devices is a function in the WirelessProfessional software, which can be used to take devices out of operation in a planned 
manner for a limited period, e.g. for restoration or alteration work.  
When devices are masked and not removed from the WirelessProfessional software,  

- their test history is retained 
- the WirelessProfessional software still knows the 4-digit wireless address 
- a space is reserved for the masked device in the address space 
- group arrangements and map assignments are also retained 

 
In order to illustrate how the WirelessProfessional software’s masking function works in a relevant real-life situation, let’s take the 
example of an installation with a total of 100 devices registered to the WirelessProfessional software. 
During the course of alteration work, 10 devices are taken out of operation or disconnected from the mains voltage. 
Since 10 devices are taken out of operation, this will result in the WirelessProfessional software issuing an event device error and 
going into fault mode. The 10 devices are therefore masked, resulting in the WirelessProfessional software again reporting an 
error-free system status. 
While the 10 devices are out of operation, 5 new devices are registered on the WirelessProfessional software. 
There are now 105 devices registered on the WirelessProfessional software.  Of the 105 devices, 10 are masked, which means that 
the WirelessProfessional software is monitoring and checking 95 devices. 
Once the alteration work is complete, the 10 devices, which were taken out of operation, are switched on again and the masking 
in the WirelessProfessional software is cancelled, meaning that 105 devices are now being monitored and checked. 
 
Note: The WirelessProfessional software also attempts to associate the masked devices. If they cannot be accessed wirelessly, 
communication errors may occur and slow down checking. The process of re-associating devices can be started by e.g. changing a 
coordinator or receiving a “Reconnect All Devices” command from a neighbouring system. 
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7 Cloud Connection 
This section explains how to connect WirelessProfessional systems to the LIGHTLINX Internet portal at RP-Technik (www.light-
linx.com), (hereinafter referred to as “cloud”). We will describe how to set up cloud access, the significance of the monitoring sym-
bols and show interactions with the cloud. 
 
From software version 3.0 onwards, the WirelessProfessional software provides scope for connecting to the cloud.1  
The cloud connection option turns the WirelessProfessional control centre into an IoT device that can be addressed directly.  
 
The WirelessProfessional software’s cloud connection is not activated upon delivery.  
 

7.1 Activating Cloud 
Select the Cloud tab and press Activate Cloud to activate the cloud connection. 
When cloud connection is activated, the cloud symbol  appears in the form of a cloud in the top banner on the left next to the 
language selection and Help menu.  
The browser set as default is opened and shows the cloud log-in page. A user registered for the cloud needs to log in to the browser 
and agree to the conditions of use and privacy policy (this only has to be done once). Once log-in is complete, the Browser tab in 
which the user logged in, prompts the user to close this tab.  
Cloud connection is then complete. 
The user who logged into the cloud can now see and manage the project in the cloud.  
 

 
Figure 45 Cloud view 

 
The WirelessProfessional control centre will now transfer status information to the cloud on a regular basis. From this point on, 
there is no need for the user to log in again because at the time of registration in the cloud, the WirelessProfessional control centre 
is given permanent access to the cloud, allowing it to upload status information.  
 
Note: Because a personalised login is undertaken when activating the cloud connection, the WirelessProfessional software receives 
extended rights for a limited period (24 hours). These are needed not only to log the control centre onto the cloud but also for 
certain additional actions (such as cloud synchronisation when adding/deleting devices or maps). If these actions are undertaken 
after this time window has lapsed, another personalised login will be needed. In this case, the WirelessProfessional software dis-
plays a note in the top right on the relevant tab view informing the user that a personalised login is needed, see Figure 46 Installa-
tion area, personalised cloud login required. Log in to the cloud as described in Section 7.3.  

 

1 Cloud connections are only available for selected distributions 
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Figure 46 Installation area, personalised cloud login required 

 
Note: When the cloud connection is activated, the WirelessProfessional emergency lighting system can be seen as a project in the 
cloud account of the user, whose personalised login is being used. If a new personalised login is required at a later point, the user 
in question must have cloud access to the project at that point in time. This means that it either needs to be the same user as 
before or a user who has previously been given access to the project by means of sharing or handover. If the user does not have 
access to the project, an error message is displayed. 
 
Note: To view information about the current cloud status, click on the cloud symbol in the top banner. 
 
Note: If the Cloud tab is not appearing despite having logged in with the installer password, then cloud connection is not supported 
for this distribution. 
 

7.2 Deactivating Cloud 
Select the Cloud tab and press Deactivate Cloud to deactivate the cloud connection. 
This means that no more uploads will be made to the cloud. The cloud symbol is also no longer shown in the top banner. 
The cloud access created internally for data uploads during the previous cloud activation is retained and is used again when the 
cloud is reactivated, meaning that a personalised login is not required to (re)activate the cloud connection.  
 

7.3 Signing In 
Select the Cloud tab and press Sign In to log into the device for 24h with your personalised cloud login.  
Once the button has been pressed, the default web browser is opened and shows the cloud login page. When you sign in with a 
personalised login, the WirelessProfessional software receives extended rights for a limited period (24 hours). These are needed 
for certain additional actions.  The WirelessProfessional software indicates when a personalised login is required.  
 
Note: If there are cloud upload or download errors present, it may take up to 1 minute for the web browser to launch. 
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Figure 47 Cloud view indicating errors 

 
If the personalised login does not have access rights for the project, error C501 is issued. Error C501 is reset by the 24h timeout for 
automatically logging out of the cloud, by issuing access rights to the cloud project or by using a personalised cloud login with 
access rights to the project.  
 

7.4 Uploading Inspection Log 
Select the Cloud tab and press Upload Inspection Log to upload the current status of the inspection log files to the cloud. This 
does not require a personalised cloud login.  
When the button is pressed, the version of the inspection log file present in the cloud is replaced by the version from the Wireless-
Professional control centre. 
An automatic upload takes place at the end of every capacity test. 
If the file size limit of the inspection log file has been reached and a new inspection log file is created, the now inactive inspection 
log file is uploaded automatically. 
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7.5 Cloud Status Display 
When the cloud connection is activated, the graphic cloud status box is activated in the WirelessProfessional software's top banner. 
The following symbols are shown here depending on any current communication traffic with the cloud. 
 

 
Table 2: Cloud status symbols 

 

7.6 Classes of Error Code 
 
Various errors relating to the cloud connection may arise. These can be grouped into classes of error code as shown in  
Table 3 below. 
 

 
Table 3 Cloud error classes 

  

Symbol Meaning 

 
Cloud connection active, no uploads or download in progress 

 

Cloud connection fault, no uploads or download in progress 

 

Cloud connection active, download from the cloud in progress 

 

Cloud connection active, the last download from the cloud caused an error  

 

Cloud connection active, upload to the cloud in progress 

 

Cloud connection active, the last upload to the cloud caused an error 

 

Cloud connection active, upload and download in progress 

 

Cloud connection active, the last upload and download caused an error 

 

Error code 
ID 

Meaning 

C0xx External error 

C1xx Log entries and info 

C2xx General error on the part of the control centre upon contact with the cloud 

C3xx General error on the part of the cloud upon contact with the cloud 

C4xx Authentication/log-in error 

C5xx LIGHTLINX web API error 
 

 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 38  

8 Software Operation Reference 
8.1 Symbols 
 

This section explains the symbols used in the WirelessProfessional software. 
Table 4 lists the colour symbols for operating statuses. The priority of a status means that the status with the highest priority is 
displayed for a device or group for which several statuses apply. For example, the blue colour symbol (emergency luminaire is 
being tested) would be displayed for a group containing an emergency luminaire with a battery error and an emergency luminaire 
which is being tested because its priority is higher than that of the red symbol (error message). One exception from this is commu-
nication errors, which arise during a test: Should they arise, a red colour symbol is displayed for the device and/or group in question 
rather than the blue symbol to draw attention to the error. 
 

 

 

 

 

 

 

 
1 Communication errors, which arise during a test, are displayed with a higher priority than the test. 
 
Table 4: Colour symbols 
 
 

8.2 Status Symbols 
 

 
 
 
Table 5: Status symbols 
 
 
8.3 Operating Statuses 
 
Table 5 shows an overview of the special operating statuses of a WirelessProfessional system. Further explanations about the 
operating statuses can be found in the glossary (Section 13). 
 

Operating status Non-maintained emer-
gency luminaires, 
switchable 

Maintained emer-
gency luminaires, 
switchable 

Function/capac-
ity test possible 

Emer-
gency 
mode 
possible 

Energy save Off Off Yes Yes 
Activate Off1 On Yes Yes 
Fire alarm On On No Yes 
Block emergency luminaires Off On No No 

1Switchable non-maintained emergency luminaires are not switched by the Activate function. Switched-off emergency luminaires 
remain switched off and switched-on emergency luminaires remain switched on. 
 
Table 6: Operating statuses 

  

Symbol  Priority Meaning 
 Yellow 5 Status is being updated 
 Blue 4 Emergency luminaire(s) is(are) being tested 
 Red 31 Error message(s) 
 Orange 2 Emergency luminaire(s) in remote inhibiting mode 
 Green 1 No error message 
 Grey - Emergency luminaire(s) is(are) masked 

Symbol Meaning 
 Maintained emergency luminaire 

 Non-maintained emergency luminaire 

 The switching status of the emergency luminaire corresponds to its operating mode 
(switched-on emergency luminaire in maintained operation and/or switched-off emer-
gency luminaire in non-maintained operation) 

 The switching status of the emergency luminaire does not correspond to its operating 
mode (switched-off emergency luminaire in maintained operation and/or switched-on 
emergency luminaire in non-maintained operation) 

 Group/system is linked to the input/output of an IO box 

 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 

Page 39  

8.4 Status Messages 
 
 
Table 7 lists the status messages for the WirelessProfessional software and explains the meaning of them. 
 

Status message Meaning 
System is being booted The system is checking that all devices can be reached 
Update The status of devices is being changed 
Device not associated Device installation in the system is not yet complete 
Block x emergency luminaires x emergency luminaires are still to be put into remote inhibiting mode 
Unblock x emergency luminaires Remote inhibiting mode still needs to be terminated for x emergency luminaires 
Fire alarm status expiring Once the fire alarm overrun time has expired, the emergency luminaires are 

switched off again 
Operational At least one switchable emergency luminaire is switched on 
Stand-by operation All switchable emergency luminaires are switched off or the system only consists 

of luminaires which cannot be switched 
Error on x devices Error messages for x devices 
Fire alarm status activated by IO box Fire alarm (signal at fire alarm input of IO box enabled). All switchable emergency 

luminaires are switched on. 
Fire alarm status is in overrun time Fire alarm terminated (signal at fire alarm input of IO box no longer enabled). The 

system is in fire alarm overrun time. Switchable emergency luminaires remain 
switched on until end of overrun time. 

Start test on x devices Testing of x devices is being started 
Inspection Status message during a test 
End test on x devices The test is completed and the test results are being transferred from the emer-

gency luminaires 
Capacity test postponed on x devices2 The test could not be started on x so there is a delay before attempting to start it 

again.  
x emergency luminaires are blocked x emergency luminaires are in remote inhibiting mode 

 
Table 7: Status messages 

 
 

 
  

 

2 Manual capacity test or automatic capacity test 
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8.5 Error Messages 
 
Table 8 lists the error messages for the WirelessProfessional software and explains the meaning of them. 
 

Error message Meaning Possible cause 
Invalid device A device is responding with an unknown type 

identification 
Device firmware is more up-to-date than Wire-
lessProfessional software 

Connection lost The radio connection to a device is inter-
rupted 

Device is in emergency mode 
Fault in radio connection to device 

Battery error The battery voltage has been outside the tol-
erance range for 1h 

Battery not connected 
Incorrect battery connected 
Battery has suffered excessive discharge 
Battery defective 

Last test*  
failed:  
Connection error 

The radio connection was interrupted during 
the test or once the test was completed 

Fault in radio connection to emergency lumi-
naire 

Last test*  
failed:  
Luminaire fault: test still 
running 

The luminaire is still being tested at the point 
at which the WirelessProfessional software 
accesses the test result 

The luminaire is checking the full autonomy 
time while a 2/3 test has been started in the 
WirelessProfessional software. 

Last test*  
failed:  
Luminaire fault: no test re-
sult 

The wireless module was not able to read a 
test result from the luminaire 

Fault in connection between wireless module 
and luminaire electronics 

Last test*  
failed:  
Battery error 

Battery error during the test Battery not connected 
Incorrect battery connected 
Battery has suffered excessive discharge 
Battery defective 

Last test*  
failed:  
Illuminant error 

Illuminant error during the test Illuminant not connected 
Illuminant defective 
Switch device defective 
Illuminant current too low 

Last test*  
failed:  
Not charged for long 
enough 

A capacity test cannot be carried out because 
the luminaire had not been charged for long 
enough 

Luminaire connected before less than 24h or 
recently experienced power supply failure 

Last test*  
failed:  
Test already running 

A test cannot be started because there is al-
ready a test running 

An attempt was made to start another test 
even though a test is already. Multiple at-
tempted starts are also possible via the timer. 

Last test*  
failed:  
Not fully charged 

A capacity test cannot be carried out because 
the luminaire had not been charged for long 
enough 

A luminaire with processor-controlled charging 
is currently charging the battery – e.g. following 
recent power supply failure 

Last test*  
failed:  
Recent capacity test 

The luminaires are in the recharge phase fol-
lowing a capacity test 

An attempt was made to start a function test in 
the recharge phase 

Last test*  
failed:  
Not associated 

Association to luminaire lost The luminaire was not associated with the sys-
tem at the start of the test 

Last test*  
failed:  
Fire alarm status enabled 

 A test was started while in the fire alarm status 
(first status emergency mode) 

Last test*  
failed: 
Not performed 

The test was not performed on this lumi-
naire. 

The luminaire was masked or invalid when the 
test was started. 
The luminaire is part of a group of luminaires 
that was to perform a test, but the test for this 
group was cancelled before the test for this lu-
minaire was started. 

 
Table 8: Error messages of the WirelessProfessional system 
 
*) – Function or capacity test  
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8.6 User Levels 
 
The rights for accessing the WirelessProfessional software functions are split into several user levels.  
Table 9 provides an overview of the user levels and their access rights. The Facility Manager, Installer and Distributor user 
levels are password-protected to prevent unauthorised use. The WirelessProfessional software launches in the Anyone user level. 
 

User level Access rights 
Anyone Read-only, no changes can be made 
Facility manager Switch devices, trigger function/capacity tests 
Installer Install devices, configure groups and automatic tests, integrate 

maps, reset facility manager password 
Distributor Define maintenance intervals, reset installer password, change 

logo 
 
Table 9: User levels of WirelessProfessional software 
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8.7 “General” View 
 
You access the General view by selecting the General tab. 
The system name, number of groups and system status are displayed in the General view. Figure 48 shows a screenshot of the 
General view for the Facility Manager or Installer user level. The buttons and their functions do not appear when in the An-
yone user level. Section 8.2 explains the meaning of the symbols used in the Status column. If there are any active error messages 
(red colour symbol), the Alarm List view can be opened by clicking or tapping on the red colour symbol. The Groups view can be opened 

by clicking or tapping in the Groups column. 
 

 

 
 
 
The functions listed in Table 10 can be performed using the buttons in the General view. 
 

Button Function User level 
Activate Switches on all switchable maintained emergency lu-

minaires 
Facility manager, installer 

Energy Save Switches off all switchable and switched-on emer-
gency luminaires  

Facility manager, installer 

Block Emergency Luminaires Puts all emergency luminaires into remote inhibiting 
mode 

Facility manager, installer 

Logout Resets the user level to Anyone Facility manager, installer 
Start Function Test Starts a function test for all emergency luminaires Facility manager, installer 
Start Capacity Test Starts a capacity test for all emergency luminaires Facility manager, installer 
Abort Test Aborts the current test.  

Any function tests currently active 
at this time are completed. 

Facility manager, installer 

Reset Fire Alarm Overrun Time Ends the overrun time after a fire alarm. 
The minimum overrun time is 10 minutes. 
This button is only enabled if a fire alarm has previ-
ously been registered and the emergency luminaires 
are in the overrun time. 

Facility manager, installer 

Table 10: Functions of the General view 
 
Note:  When you log out manually, you will be asked whether you want to save the system. When you log out automatically, you 
are not asked this. 
 

Figure 48: General view, facility manager and installer user levels 
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Figure 49: Save system dialogue 

 
8.8 “Alarm List” View 
 
You access the Alarm List view by selecting the Alarm List tab. 
The Alarm List view displays all devices in the system reporting an error. The defective devices are arranged by group. The name of the 
device as well as its address and status (as colour symbol and in plain text) are displayed. If a device is reporting several errors at 
the same time, this is shown in plain text. Section 5.1 explains the meaning of the symbols used in the Status column. Section 8.5 
contains an overview of the possible error messages. Figure 50 shows a screenshot of the Alarm List view for the Facility Man-
ager or Installer user level. Not all buttons are available when in the Anyone user level. 
 

 

 
 
The functions listed in Table 11 can be performed via the context menu for the error messages (Figure 50). 
 
Note: You can highlight one or more devices at the same time. Instructions for multiple highlighting can be found in Section 1.3.2. 
 

 
Table 11: Functions of context menu in Alarm List view 

Menu entry Function User level 
Device Detail Dialog Displays detailed information, such as mounting 

location,  
operating mode etc. for the selected device 

Anyone 

Start Function Test for Luminaire 
<Name> 

Starts a function test for this emergency luminaire Facility manager, installer 

Start Capacity Test for Luminaire 
<Name> 

Starts a capacity test for this emergency luminaire Facility manager, installer 

Block Luminaire <Name> Puts emergency luminaire into remote inhibiting 
mode 

Installer 

Unblock Ends remote inhibiting mode for emergency lumi-
naire 

Installer 

Show on Map Shows this emergency luminaire on the map Anyone 

Figure 50: Alarm List view, facility manager and installer user levels 
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A function or capacity test can only be started if the batteries of the emergency luminaires are adequately charged (see Sections 
2.2 and 2.3). 
 
The functions listed in Table 12 can be performed using the buttons in the Alarm List view. 
 

Button Function User level 
Reset Error Messages All error messages currently active are reset. Acknowledgement 

of the error messages is recorded in the inspection log. 
Facility manager, installer 

Inspection Log Opens the test run progress (see Section 8.8.1) Anyone 
Operationtime Log Not implemented Anyone 
Communications Log Opens the communications log (see Section Kommu-

nikationslog) 
Anyone 

System Log Opens the system log (see Section Systemlog) Anyone 
Start Function Test Starts a function test for all emergency luminaires Facility manager, installer 
Start Capacity Test Starts a capacity test for all emergency luminaires Facility manager, installer 
Logout Resets the user level to Anyone Facility manager, installer 

 
Table 12: Buttons of the Alarm List view 
 
Note: The Reset Error Messages button is only visible if the resetting of errors has been activated for the corresponding user level 
in the distributor area. 
 
A function or capacity test can only be started if the batteries of the emergency luminaires are adequately charged (see Sections 
2.2 and 2.3). 
 
 

8.8.1 Test Run Progress 
 
The results of function and capacity tests are stored in the test run progress along with other messages. The test run progress is 
opened by pressing the Inspection Log button in the Alarm List view. Figure 51 shows a screenshot of the opened test run 
progress. 
 

 
 
The messages in the test run progress are saved in the inspection_log.txt file. If the size of this file exceeds 4 MB, the content 
of the file is archived under inspection_log_<date>.txt and removed from the inspection_log file. When opened, the last 500 
entries from the inspection log are loaded. All entries can be loaded by clicking on the “Load all” button. 
The functions listed in Table 13 can be performed using the buttons from the test run progress. 
 

 

 

 
 
 

Button Function User level 

Figure 51: Inspection log 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 

Page 45  

Load all Loads all the inspection log entries Anyone 
Copy to Clipboard Copies the test run progress messages to the clipboard Anyone 
Add Message Manual input of messages. Once a message has been entered manually, the 

Refresh button must be pressed in order for the message to be listed in the 
test run progress. Messages entered manually cannot be deleted from the test 
run progress. 

Anyone 

Open Old Log Opens an archived test run progress Anyone 
Refresh Updates the test run progress messages Anyone 
OK Closes the test run progress window Anyone 

 
Table 13: Functions of buttons in test run progress 
 

8.8.2 Communications Log 
 
Error messages from radio network communication are recorded in the communications log. The start time of the WirelessProfes-
sional software and the start time of the connection to a USB coordinator are also recorded. Figure 52 shows a screenshot of the 
communications log. 
 

 

 
 
The messages in the communications log are saved in the communication.log file. If the size of this file exceeds 4 MB, the 
content of the file is archived under communication_<date>.log and removed from the communication.log file. When 
opened, the last 500 entries from the communications log are loaded. All entries can be loaded by clicking on the “Load all” button. 
The functions listed in Table 14 can be performed using the buttons from the communications log. 
 

Button Function User level 
Load all Loads all the communications log entries 

(Only the last 500 entries are displayed by default) 
Anyone 

Copy to Clipboard Copies the test run progress messages to the clipboard Anyone 
Open Old Log Opens an archived communications log file Anyone 
Refresh Updates the communications log messages Anyone 
OK Closes the communications log window Anyone 

 
Table 14: Functions of buttons in communications log 
 
  

Figure 52: Communications log 
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8.8.3 System Log 
 
All configuration and status changes to the system are recorded in the system log.  
Figure 53 shows a screenshot of the system log. 
 

 

 
 
 
The messages in the system log are saved in the system.log file. If the size of this file exceeds 4 MB, the content of the file is 
archived under system_<date>.log and removed from the system.log file. When opened, the last 500 entries from the system 
log are loaded. All entries can be loaded by clicking on the “Load all” button. The functions listed in Table 15 can be performed 
using the buttons from the system log. 
 
 

Button Function User level 
Load all Loads all the system log entries 

(Only the last 500 entries of the system log 
are displayed by default) 

Anyone 

Copy to Clipboard Copies the system log messages to the clip-
board 

Anyone 

Open Old Log Opens an old system log file Anyone 
Refresh Updates the system log messages Anyone 
OK Closes the system log window Anyone 

 
Table 15: Functions of buttons in system log 
  

Figure 53: System log 

: 
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8.9 “Groups” View 
 
You access the Groups view by selecting the Groups tab. 
The Groups view shows the groups created in the system as well as the devices in each group. Figure 54 shows a screenshot of the Groups 
view. 
 

 

 
 
A test that is currently active can be aborted using the Abort Test button. (see Table 10: Functions of the General view) Devices, 
which do not support aborting tests, pause until the end of the test time for the capacity test that has already been started. 
The groups created in the system are displayed in the top part of the Groups view. The columns in the top part show the name of 
the group or system, status and number of emergency luminaires, repeaters and IO boxes. Section 5.1 explains the meaning of the 
symbols used in the Status column. The buttons in the Maintained Luminaires and Non-maintained Luminaires columns 
allow emergency luminaires of the respective operating mode to be switched on or off. This function is only available at the facility manager 
and installer user levels and only if the system contains switchable emergency luminaires. A red frame around the On or Off 
button indicates that the emergency luminaires are switched off in maintained operation or switched on in non-maintained oper-
ation. 
The functions listed in Table 16 can be performed via the context menu for the groups (Figure 54). The functions take effect for all 
emergency luminaires within the selected group in each case. 
 

 
Table 16: Functions of context menu in upper part of Groups view 
 

Menu entry Function User level 
Dimming Settings The option of dimming all emergency lumi-

naires in this group when in normal and emer-
gency mode (see  

Figure 56) 

Facility manager, installer 

Start Function Test for Group <Name> Starts a function test for all emergency lumi-
naires in this group 

Facility manager, installer 

Start Capacity Test for Group <Name> Starts a capacity test for all emergency lumi-
naires in this group 

Facility manager, installer 

Block Group <Name> Puts all emergency luminaires in this group 
into remote inhibiting mode 

Facility manager, installer 

Unblock Ends remote inhibiting mode for emergency lu-
minaires in this group 

Facility manager, installer 

Figure 54: Groups view, facility manager and installer user levels 
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A function or capacity test can only be started if the batteries of the emergency luminaires are adequately charged (see Sections 
2.2 and 2.3). 
The devices of the group selected in the upper part of the Groups view are displayed in the lower part (Figure 55). The name of the 
device, its address, status, operating mode (if dealing with an emergency luminaire), the position of the luminaire and device type 
are displayed in the columns of the lower part. The buttons in the Switch Luminaires column allow switchable emergency lumi-
naires to be switched on or off. This function is only available at the facility manager and installer user levels and only if the respec-
tive emergency luminaire can be switched. A red frame around the On or Off button indicates that an emergency luminaire is 
switched off in maintained operation or switched on in non-maintained operation. 
 

 

 
 
 
The functions listed in Table 17 can be performed via the context menu for the devices (Figure 55). 
Note: You can highlight one or more devices at the same time. Instructions for multiple highlighting can be found in Section 1.3.2. 
 

Table 17: Functions of context menu in lower part of Groups view 
 
  

Menu entry Function User level 
Device Detail Dialog Displays details for the selected device Anyone 
Dimming Settings The option of dimming this luminaire 

when in normal and emergency mode ( 
Figure 56: Luminaire dimming settings) 

Facility manager, installer 

Start Function Test for Luminaire <Name> Starts a function test for this emergency lu-
minaire 

Facility manager, installer 

Start Capacity Test for Luminaire <Name> Starts a capacity test for this emergency lu-
minaire 

Facility manager, installer 

Block Luminaire <Name> Puts this emergency luminaire into remote 
inhibiting mode 

Facility manager, installer 

Unblock Ends remote inhibiting mode for this emer-
gency luminaire 

Facility manager, installer 

Show on Map Shows this device luminaire on the map Anyone 
   

Figure 55: Groups view, facility manager and installer user levels 
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A function or capacity test can only be started if the batteries of the emergency luminaires are adequately charged (see Sections 
2.2 and 2.3). 
 

 
Figure 56: Luminaire dimming settings 

 

Note: If a luminaire supports the dimming function, the Dimming Settings menu item can be selected. If a group contains some 
luminaires which do not support this feature and some which do, the Dimming Settings menu item is available to the group. 
Dimming is however only undertaken on those luminaires which support the feature.  
The dimming of emergency luminaires may only be undertaken in accordance with locally valid provisions and the official emer-
gency lighting plan for the building such that sufficient emergency lighting can be guaranteed at all times. 
 

8.10 “Maps” View 
 
You access the Maps view by selecting the Maps tab. 
The Maps view allows maps to be added to the system and the luminaires installed in the system to be positioned on the maps such 
that the mounting location of a luminaire can be found at any time. The functions of the Maps view are only available to the Installer 

user level. The maps can only be viewed when in the Anyone and Facility Manager user levels. 
 

 

 
 
 
The Maps view is divided up yet further into the list of maps (Figure 57) and graphic view of maps along with the devices positioned 
within it (Figure 59). You can switch between the two views using the Toggle Map View button. 
  

Figure 57: Maps view (list of maps), installer user level 
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8.10.1 “List of Maps” View 
 
You can add new maps by selecting Add New Map in the context menu of the Maps in system area (Figure 57). Go to the file 
dialogue for the data carrier on which the maps are located. Highlight the maps you want to add, and confirm the selection by 
clicking on Open. The following graphics file formats are supported: .bmp, .jpg and .png. The maximum size of the maps is 10 
mega pixels. Larger maps cannot be loaded into the WirelessProfessional system. 
You can sort the list of maps by highlighting an entry and dragging it to the desired position within the list. 
The context menu for maps in the Maps in system area (Figure 57) contains the Add New Map, Rename Map <Name>, 
Delete map <Name> and Switch to Map View of <Name> functions. 
A view of the building can be integrated in the right-hand part of the List of Maps view. You add a building view by opening the 
context menu in the grey rectangle and/or building view at the right-hand edge of the window and selecting Select New Building 
Logo (Figure 58). Go to the file dialogue for the data carrier on which the building view is located. Select the building view and 
confirm the selection by clicking on Open. 
Click or tap twice on an entry in the list of maps to go to the graphic view of this map. 
Once you have made changes to the maps, select Save System Data to confirm the changes. 
 

 

 

 
  

Figure 58: Maps view (list of maps), installer user level 
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8.10.2 Graphic “View of Maps” 
 
The devices installed in the system can be positioned on the maps in the graphic view of maps. Figure 59 shows a screenshot of 
the graphic view of maps. 
You access the graphic view of maps by clicking on the Toggle Map View button or by double-clicking or tapping twice on an entry 
in the list of maps. 
The devices installed in the system are listed, sorted into groups, in the left-hand part of the view. You position a device on a map 
by highlighting the device in the left-hand part and dragging it to its mounting location on the map in the right-hand part. Devices 
which have been positioned on a map are automatically removed from the list in the left-hand part. 
The map shown in the right-hand part can be selected from the drop-down selection list above the right-hand part. A map can also 
be selected using the arrow buttons located to the right and left of the drop-down selection list. 
The slide control above the right-hand part can be used to adjust the scale of the map displayed and the scrollbars below and to 
the right of the map can be used to select the relevant image section. 
 

 

 
 
 
The functions listed in Table 18 can be performed using the buttons in the graphic view of maps. 
 

Button Function User level 
Reset Node Positions Deletes all devices from the map currently on display Installer 
Toggle Map View Switches between the list and graphic view of maps Anyone 
Save System Data Saves all changes to the system configuration Installer 

 
Table 18: Functions of buttons in graphic view of maps 
 
Once you have made changes in the graphic view of maps, select Save System Data to confirm the changes. 
 
  

Figure 59: Maps view (graphic view), installer user level 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 52  

8.11 “Email ” View 
 
You access the Email view by selecting the Email tab. To be able to see this tab, you have to log in at facility manager level or 
higher. 
 

 

 
 
 
The WirelessProfessional software provides the option of sending an email to a previously defined email address when certain 
events occur. The settings for sending these emails can be configured in the Email view. To use this function, you need an email 
account from which the emails can be sent, and the PC must have an Internet connection. Emails can be sent via a secure SSL 
connection. 
Figure 60 shows a screenshot of the Email view. 
  

Figure 60: Email view, facility manager and installer user levels 
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Table 19 lists the boxes in the Email view and their meanings. 
 

Box Meaning 
Sender Sender’s email address 
Subject Entry in subject line of email 
Email address Receiver’s email address Use commas if sending to several different email addresses, e.g. 

receiver1@domain1.de, receiver2@domain2.de, ... 
SMTP server SMTP server from which the emails are sent 
Port The port via which the emails are to be sent (usually port 25, 587 or 465) 
SMTP server login Login for the SMTP server 
SMTP server password Password for the SMTP server. The WirelessProfessional software only supports SMTP serv-

ers with a password login. 
Wait time Time after an event has occurred before an email is sent. During this time, the system waits 

for further events so that several events can be bundled in one email. 
Radio fault Email dispatch in the event of a radio fault 
Battery error Email dispatch in the event of a battery fault 
Also report temporary faults An email is sent even if the fault has been remedied before the end of the wait time. 
Mail delivery on function test Choose between 

email is sent after all function tests (all tests) 
email is only sent after function tests in which errors occurred (failed tests) 
emails are not sent after function tests (never) 

Mail delivery on capacity test Choose between 
email is sent after all capacity tests (all tests) 
email is only sent after capacity tests in which errors occurred (failed tests) 
emails are not sent after capacity tests (never) 

Blocking luminaire Email is sent when emergency luminaire(s) is(are) put into remote inhibiting mode 
Emergency status change Email is sent when the signal status at the fire alarm input on the IO box changes (fire alarm 

starting or fire alarm ending) 
Installer login Email is sent when a user logs in as installer 
Logout time Users logged in as facility manager or installer are automatically logged out if no user activity 

is detected for the time set here. This function serves to automatically log out facility manag-
ers or installers who have forgotten to log out. 

 
Table 19: Boxes in Email view 
 
 
The functions listed in Table 20 can be performed using the buttons in the Email view. 
 

Button Function User level 
Change Facility Manager 
Password 

Change the password for the facility manager user level Facility manager, installer 

Send Test Mail Sends a test email Facility manager, installer 
Save System Data Saves all changes to the system configuration Facility manager, installer 

 
Table 20: Functions of buttons in Email view 
 
 
Once you have made changes in the Email view, confirm the changes by clicking on the Save System Data button. 
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8.12 “Installation ” View 
 
You access the Installation view by selecting the Installation tab. The Installation tab is only available at the installer user level. 
The Installation view is divided up into the Configure Groups, Test, Timer, Remote Facilities and System views using tabs. 
 
 

8.12.1 “Configure Groups” View 
 
You access the Configure Groups view by selecting the Configure Groups tab in the Installation view. The Configure 
Groups view allows new devices to be added to the system and groups to be created and managed. Figure 61 shows a screenshot 
of the Configure Groups view. 

 

 

 
 
The first line in the Registered nodes area shows the name and properties of the system. Under this you can see the groups 
created in the system and the devices in the groups. Click or tap on the triangle to the left of a group to expand this group and to 
display the devices in this group or to collapse this group again. 
The columns in the Registered nodes area show the name of the group or device, status and number of emergency luminaires, 
repeaters and IO boxes in the group. 
Section 5.1 explains the meaning of the symbols used in the Status column. 
The functions listed in  
Table 21 can be performed via the context menu for the entries in the Registered nodes area (Figure 62). The context menu 
entries vary depending on whether the context menu for a group or device is called up. 
At distributor user level, the Address column also shows information about the version of the wireless module fitted in the device. 

Figure 61: Configure Groups view, distributor user level 
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Table 21: Functions of context menu in Registered Nodes area, Configure Groups view 
 
If the context menu of the Set capacity test duration for luminaire 'Name’ is selected, the Autonomy time settings window opens. 

 

 
Figure 63: Autonomy time settings window 

Menu entry Function User level 
Mask x luminaires, x repeaters and  
x IO boxes/Mask luminaire 'Name' 

Masks the device/devices (errors are not shown) Installer 

Unmask Devices Cancels the masking of masked devices Installer 
Start Function Test for Luminaire 'Name'/ for 
Group 'Name’ 

Starts a function test for this emergency lumi-
naire/emergency luminaires in this group 

Installer 

Rename group 'Name' / luminaire 'Name' Renames groups/emergency luminaires Installer 
Add Group Adds a sub-group to a group and/or system. This 

function is only enabled in the context menu for 
groups/the system 

Installer 

Delete group 'Name' / luminaire 'Name' Deletes the group/device from the system Installer 
Set capacity test duration for group 'Name' / lu-
minaire 'Name' 

The option of shortening the autonomy time (and/or 
test duration) of the selected luminaire or all lumi-
naires in a group from the control centre. See note 

Installer 

Figure 62: Configure Groups view - context menu 
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The current autonomy time is shown in the Autonomy time settings window. A new autonomy time can be selected using the 
drop-down list.  
 
Only an autonomy time, which is the same as or shorter than the initial autonomy time, can be selected here. 
This may result in an increase in the light current.  

Warning: Changes to the autonomy time of emergency luminaires may only be made in accordance with locally valid pro-
visions and the official emergency lighting plan for the building such that sufficient emergency lighting can be guaranteed 
at all times. 

 
Note: Autonomy time settings are supported in wireless module version 2.1 (15) and higher. if the luminaire does not support this 
function, this menu item is not available. If a group contains both some luminaires which do not support this feature and some 
which do, this menu item is available. If the menu item for setting the capacity test duration for luminaires is selected for such a 
group, a note appears informing the user of which devices do not support this feature. The autonomy time for the remaining 
devices can be changed by pressing the Yes button. 
 

 
Figure 64: Note relating to changing the autonomy time 

 
The luminaire(s) then changes(change) briefly into the Refresh status. As soon as the luminaire(s) returns(return) to the OK status, 
the change takes effect and is displayed accordingly in the device details (see Figure 88). 
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The Unknown nodes area shows the devices, which have a radio connection and which are not yet installed in a system. The 
list of devices is split into the Luminaires, Repeaters and IO Boxes device types. Devices which are not supported by the 
installed version of the WirelessProfessional software are shown as Not usable in the Unknown nodes area. Devices where 
the radio connection has been interrupted for more than 5 minutes are removed from the Unknown nodes area. 
Devices from the Unknown nodes area are added to the system by highlighting them in the Unknown nodes area(Figure 65) 
and dragging them into the Registered nodes area. The devices are then installed one after another in the system. The remain-
ing number of devices not yet installed is displayed in the first line of the Registered nodes area (x devices not associated). 
The time needed for this may vary depending on how the devices are arranged in the radio network and how far the installation 
has progressed (anything from several seconds to several minutes per luminaire). 
 

 

 
 

Warning: During the installation, position the USB coordinator so that it has a direct radio connection with fewer than 50 
devices (for details, see Section 8.13, “Network Information). 
Devices, which have been installed in a system, only pass on data packets from devices in the same system. If devices are 

added to a system individually, the following scenario may therefore arise: A device, which is mounted a long way away from the 
USB coordinator, is added to the system. The devices, which are mounted between this device and the USB coordinator and which 
are needed to pass on data packets, may however not yet have been installed in the system. The distant device may then not be 
contactable in the radio network. This is the reason why all devices that are to be installed in the system should be highlighted in 
the Unknown nodes area and dragged at the same time into the Registered nodes area. 
  

Figure 65: Configure Groups view, installer user level 

 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 58  

The functions listed in Table 22 can be performed via the context menu for the entries in the Unknown nodes area (Figure 66).  
 

 

 
 

Menu entry Function User level 
Add to group Adds the selected device to a group Installer 
Delete Device 'Address' Deletes the device from the Unknown nodes area Installer 
Add New Luminaire Add emergency luminaire manually Installer 
Add New Repeater Add repeater manually Installer 
Add New IO Box Add IO box manually Installer 

 
Table 22: Functions of context menu in Unknown nodes area, Configure Groups view 
 
 
The Add New Luminaire/New Repeater/New IO Box functions allow devices to be added to the system manually without 
there being any radio contact with these devices. The addresses of these devices must be known in order to add them manually.  
 

 
Figure 67: Address for the New Device 

 

The button can be used to access the on-screen keyboard directly from the WirelessProfessional software.  

Manually created devices can also be dragged out of the Unknown nodes area into the Registered nodes area just like other 
devices. 
 
Important!   
Manually created devices can only be added provided that there are fewer than 250 devices in the system.  
 
The colour status of manually added devices remains yellow until there is radio contact with the device. Then it changes to green. 
This function can be used to create an emergency lighting system in the WirelessProfessional software without the user having to 
be physically present at the system’s mounting location. 

Figure 66: Configure Groups view - context menu 
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If a 4-digit device address is entered in the Address for the New Device window and Delete is pressed, the system ID is removed 
from the device with this address. While the system ID is being removed, the device is displayed with the name TempNode[Ad-
dress] (Figure 68) and once the system ID has been removed from the device, it is automatically removed from the system. 

 
Figure 68: Display showing device to be deleted 

 
 

The Delete Device 'Address' function deletes the device from the Unknown nodes area. This simply removes the device from 
the list. Should the device continue to transmit connection requests, the address will be displayed again. 
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8.12.2 “Test” View 
 
You access the Test view by selecting the Test tab in the Installation view. 
 

 

 
 
 
The WirelessProfessional system performs automatic tests on safety lighting systems in accordance with DIN EN 50172 and DIN 
EN 62034. The capacity test and function test can be configured in the Test view. Figure 69 shows a screenshot of the Test view. 
 
Table 23 lists the boxes in the Capacity test area and their meanings. 
 

Box Meaning 
Interval Interval between two capacity tests. Choose between manual, quarterly, every 4 months, every 6 

months, yearly. If manual is selected, the automatic test is deactivated 
Time Time at which the test starts. Select a time at which the building is most probably not being used. 
Part 1 Not implemented 
Part 2 Not implemented 
Interval between 
parts 

Not implemented 

Start date Select the date for the next capacity test 
Next capacity test The date of the next capacity test is only displayed once changes have been confirmed by selecting 

Save System Data 
 
Table 23: Boxes in Test view, Capacity test area 
 
A function or capacity test can only be started if the batteries of the emergency luminaires are adequately charged (see Sections 
2.2 and 2.3). 
If an automatic capacity test is started and one or more emergency luminaires are not adequately charged (see Sections 2.2 and 
2.3), the capacity test for these emergency luminaires is postponed by 24 h. After 24 h, another attempt is made to run the capacity 
test for the emergency luminaires. The software will try up to three times to run a capacity test for the emergency luminaires.  

Figure 69: Test view, installer user level 
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Table 24 lists the boxes in the Function test area and their meanings. 
 

Box Meaning 
Interval Interval between two function tests. Choose between manual, daily and weekly. If manual is selected, 

the automatic test is deactivated. 
Time Time at which the test is started. Select a time at which the building is most probably not being used. 
Weekday Day of the week on which the function test is carried out (if weekly is selected in the Interval box) 
Next function test The date of the next function test is only displayed once changes have been confirmed by selecting 

Save System Data 
Table 24: Boxes in Test view, Function test area 
 
Once you have made changes in the Test view, select Save System Data to confirm the changes. 
 
 

8.12.3 “Timer” View 
 
You access the Timer view by selecting the Timer tab in the Installation view. 
Timers can be used to assign to luminaires functions, which are carried out at defined times. Figure 70 shows a screenshot of the 
Timer view. 
 

 

 
 
 
The functions listed in Table 25 can be performed using the buttons in the Timer view. 
 

Button Function User level 
New Timer Opens the Configure Timer window (Figure 71) to configure a new 

timer 
Installer 

Edit Timer Opens the Configure Timer window (Figure 71) for the highlighted 
timer 

Installer 

Activate/Deactivate Timer Activates/deactivates the highlighted timer Installer 
Delete Timer Deletes the highlighted timer Installer 

 
Table 25: Functions of the Timer view 
  

Figure 70: Timer view, installer user level 
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The New Timer and Edit Timer buttons open the Configure Timer window (Figure 71) for configuring a timer. Table 26 lists the 
boxes in the Configure Timer window and their meanings. 
 

 

 
 
 

 

 
Table 26: Boxes in Configure Timer window 
 
Once you have made changes in the Timer view, select Save System Data to confirm the changes. 
 
Note: Only the switch-on time should be set for function and capacity tests. Otherwise an error message will appear. 
 

 
Figure 72: Timer programming error 

  

Box Meaning 
Name Name of timer 
Start Date Date from which the timer is active 
End Data Date after which the timer is no longer active 
Switch-On Time Time at which the emergency luminaires are switched on 
Switch-Off Time Time at which the emergency luminaires are switched off 
Days Select the days on which the switching function is to be run or select Daily 
Operating mode Select the switching function to be run. Choose between: 

Switch Maintained Luminaires 
Switch Non-Maintained Luminaires 
Energy Save (switches off all switchable and switched-on luminaires in the system) 
Activate (switches on all switchable luminaires in the system in maintained operation) 
Function Test (trigger a manual function test for selected groups) 
Capacity Test (trigger a manual capacity test for selected groups) 

Groups to switch Select the groups whose luminaires are to be switched 

Figure 71: Configure Timer window 
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Timer-controlled function and/or capacity tests can be used to allow the system to run function or capacity tests in sections. 
The capacity test is run as explained in Section 2.2 by means of a schedule. 
 
Note: If there are two timers triggering function tests, an interval of 1h must be programmed between them. 
 

 
Figure 73: Overview of programmed timers 

 

8.12.4 “Remote Facilities” View 
 
You access the Remote Facilities view by selecting the Remote Facilities tab in the Installation view. 
In addition to its own devices, the Wireless Professional software can also monitor a Wireless Professional control centre connected 
via Ethernet and systems of the multiControl plus series. 
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Figure 74: Remote Facilities view, installer user level 
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The New Remote Facility buttons opens the window for configuring networked systems. 
 

 
Figure 75: Input box for remote facility 

Enter any name for the system you want to monitor (for example: WLTOUCH). In the “Remote computer” box, enter the IP address 
or device name of the system in question and the port. Then select the Test Connection button to test the connection to it. 

• Default port for WLCPC: 80 
• Default port for systems in the multiControl plus series: 81 
• Default port for WLZent: 8080 

Once the connection to the system you want to monitor is established successfully ( ), configure the update delay. This is used 
to set how often data from the remote system is queried. You can choose between 10 seconds, 1 minute and 10 minutes. 
 
Note: A remote facility may be a system from the multiControl plus series (XML version 1) or a Wireless Professional system. The 
type of remote access can also be selected. 
 
 

 
Figure 76: Connection test for remote facility  
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All the systems to be monitored are listed along with their name, IP address and status. The configuration menu of the system in 
question can be called up again and edited by selecting the Edit Remote Facility button. Systems highlighted accordingly can be 
removed from monitoring by selecting the Delete Remote Facility button. 
 
 

 
Figure 77: Overview of remote facilities 

 
The number of systems which can be monitored is limited to 1 by default  
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In the General view, along with the main system you will now also see the systems to be monitored by the main system.  
 

 
Figure 78: Monitoring remote facilities 

 

Remote access to the system in question is established by double-clicking or tapping twice in the “No. Groups” or “Status” column 
of the respective system provided that this device supports the remote access option.  
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8.12.5 “System” View 
 
You access the System view by selecting the System tab in the Installation view. 
In the System view, contact details for the installer are entered and other settings affecting the entire system are configured. Figure 
79 shows a screenshot of the System view.  
 
Table 27 lists the boxes in the System view and their meanings. 
 

Box Meaning 
First name, Last name, Company, 
Phone, Email 

Installer’s contact details. These contact details are displayed in the Maintenance Due 
reminder window. 

System name Name of the WirelessProfessional system 
Time to connection error Time between a radio fault occurring and an error being reported. This parameter applies 

to all devices other than IO boxes. 
Time to connection error for IO 
Boxes 

Time between a radio fault to an IO box occurring and an error being reported. Alongside 
the error message, the relay of output 1 on the IO box (event device error function) also 
de-energises. 

Emergency follow-up time Time between the fire alarm signal being deactivated and the emergency luminaires be-
ing switched off. If Manual Retraction is selected, the overrun time has to be manually 
terminated using the Reset Fire Alarm Overrun Time button in the General view. 

Commands waiting Number of commands which are still waiting to be transmitted to a device 
Commands in execution Number of commands in the USB coordinator’s output buffer 

 
Table 27: Boxes in System view 
 
 
The longer of the two Time to connection error or Time to connection error for IO Boxes times is also the minimum 
period for which the automatic test system remains in the Status is being updated operating status (colour symbol ) after a 
reboot. The system cannot switch into the No error message status (colour symbol ) before this time because an error, pre-
sent before the time when the system launches, will result in an error message after the Time to connection error time. 
 

 

 
 
 
 

Figure 79: System view, installer user level 
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If installation has been interrupted or if the coordinator is changed, the system ID must be re-entered in all devices. This is done 
using the Reconnect All Devices button. During this process, the system assignment is temporarily deleted from the devices. They 
are however still shown in the Registered nodes area. Devices of other systems within range are temporarily shown in the 
Unknown nodes area (Changing USB Coordinator 11.7).  
 

Warning: The Reconnect All Devices function is performed in all other systems within range. Given that this process in-
volves a high volume of radio traffic, it may take several hours to complete. 
Once you have made changes in the Configure Groups view, select Save System Data to confirm the changes. 

 
The functions listed in Table 28 can be performed using the buttons in the System view. 
 

Button Function User level 
Serial Port Manual selection of port for USB coordinator Installer 
Change Installer Password Change the installer password Installer 
Reset Facility Manager Password Reset the facility manager password to 1111 Installer 
Import Inspection Log Not implemented Installer 
Export Groups Exports the group structure into a file with comma-sepa-

rated formatting (comma separated values, csv) 
Installer 

Reconnect All Devices All devices assigned to the system are allocated the system 
ID of the coordinator currently connected 

 

 
Table 28: Functions of the System view 
 
 
Once you have made changes in the System view, select Save System Data to confirm the changes. 
 

8.12.6 “Project ” View 
You access the Project view by selecting the Project tab in the Installation view. 
The address data for the building and/or project are entered in the Project view. The address data entered is used in the cloud to 
localise the project. Figure 80 shows a screenshot of the Project view. 
 

Table 29 lists the boxes in the System view and their meanings. 
 

Box Meaning 
Project name Name of the project 
Building Name Additional name of building 
Address Line 1: Building number and name of street 
Address Line 2: Building number and name of street 
Postal Code Postal code of building  
City Name of city or town where the building is located 
Region Federal state in which the city or town is located 
Country Name of country 

 

Table 29 Boxes in the Project view 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 70  

 
Figure 80 Project view, installer user level 
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8.13 “Network Information” View 
 
You access the Network Information view by selecting the Network Information tab. The Network Information tab 
is only available at the Installer and Distributor user levels. 
The top part of the Network Information view shows the radio signal strength of the devices, which have a direct radio connection to the 
USB coordinator. The devices with a direct radio connection to the USB coordinator are highlighted in Figure 81. Figure 82 shows a 
screenshot of the Network Information view. The height of the bar indicates the radio signal strength. The device addresses 
are displayed above the bar. 
Once a signal from a device has been received and the radio signal strength measured, a 4-minute timer is started. While the timer 
is running, the colour of the radio signal strength bar for this device changes from green to grey. If the 4-minute timer elapses 
without a new measurement being received for the device, the device is removed from the view. 
 

 
 

 
  

1. Device with a direct radio connection to the USB coordinator 
2. USB coordinator 
3. Computer 
4. Device with a direct radio connection to the USB coordinator 
5. Send/receive radius of USB coordinator 

Figure 81: Devices with a direct radio connection to the USB coordinator 
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The bottom part of the Network Information view serves to measure various radio network parameters, which may prove 
useful for problem-solving. If a measurement is needed, the distributor will handle this or will ask you to take the measurement 
and provide him or her with the results. 
Start the measurement by selecting the Measure 1 Minute, Measure 10 Minutes or Measure 1 Hour button. 
Before starting a measurement lasting more than one hour, set the logout time in the Email view to never and confirm the change 
with Save System Data. 
 
The number of data packets passing between the coordinator and WirelessProfessional software can be artificially raised by ticking 
the “Increase USB Traffic” button. The tick in the checkbox is automatically removed when the Network Information view is exited 
or once the measurement has been started.3  
 
Table 30: Measurements in the bottom part of the Network Information view lists the measurements and their meanings. 
  

 

3 Should only be used in agreement with a service technician 

Figure 82: Network Information  view, installer user level 

 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 

Page 73  

Measurement Meaning 
Packets from directly connected 
nodes 

Number of radio packets per minute from devices with a direct radio connection to the 
USB coordinator. The colour symbol for this measurement turns yellow or red if too 
many devices have a direct radio connection to the USB coordinator. 

Total requests received Total number of requests per minute from devices to the automatic test system 
Association requests received Number of requests per minute from devices not yet installed in a system. 
Heartbeats received Radio network measurement 
UART sent to / received by Coordina-
tor 

Number of data packets, which the WirelessProfessional software has sent to the USB 
coordinator and the number of data packets, which have been received by the USB 
coordinator  

UART send error rate Error rate calculated from the ratio of packets sent and packets received by the recipi-
ent 

Total requests sent Number of requests per minute from the automatic test system to devices 
Total request error rate Percentage of requests, which cannot be transmitted to the devices. 
USB error rate Percentage of requests, which cannot be transmitted to the USB coordinator via the 

USB connection. 
Est. radio errors  
UART received from / sent by Coordi-
nator 

Number of data packets, which the USB coordinator has sent to the WirelessProfes-
sional software and the number of data packets, which have been received by the Wire-
lessProfessional software  

UART receive error rate Error rate calculated from the ratio of packets received and packets sent by the sender 
 
Table 30: Measurements in the bottom part of the Network Information view 
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8.14 “Cloud ” View 
 
You access the Cloud view by selecting the Cloud tab. The Cloud tab is available in the installer user level and higher. In the anyone 
and facility manager user levels, the Cloud tab can be displayed via the Help menu in the banner.  
The cloud server data is displayed and other settings relating to cloud communication are configured in the Cloud view. Figure 84 
shows a screenshot of the Cloud view. 
 

Table 31 lists the boxes in the Cloud view and their meanings. 
 

Box Meaning 
Project Name Name of the project (see  

Table 29) 
Azure API Url Web address of the API 
Azure API Port Port, which the API uses 
Azure Api Authority Link to user login page to create the user token 
Azure Api Client Id ID of server instance  
Azure Host Name Internal Azure server URL  
Azure Functions Url Web address of the API function 
Azure Functions Port Port, which the API function uses 
Terms Display Port Local port for the web browser for accepting the terms and conditions of use 
User Token Port Local port via which the user token is exchanged between web browser and LLXC 
Azure API Timeout (s) Timeout in seconds for requests to the Cloud Api 
IOT Hub Message 
Timeout (s) 

Timeout in seconds for requests to the Azure IOT hub 

Display Name  Initially, “Cloud” is entered. The tab name is taken from this box. 
Auto Close Browser If this checkbox is ticked, the web browser opened automatically to log in to the cloud is closed 

again once the device has successfully logged in. 
IOT Hub Use Web Sockets If this checkbox is ticked, the IOT hub uses ports that also use websites rather than the ports en-

tered here.  
 

Table 31 Boxes in the Cloud view 

 

Parameters relating to the cloud can only be modified if you have used the manufacturer login. Network and display parameters 
can, however, be modified at the installer user level. 
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Figure 83 Cloud view, installer user level  
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The functions listed in  

Table 32 can be performed using the buttons in the Cloud view. 
 

Button Function User level 
Sign In Opens the web browser and prompts the user to log in to 

the cloud 
Anyone 

Upload Inspection Log Uploads the inspection log to the cloud Anyone 
Activate/Deactivate Cloud Activates or deactivates the exchange of data with the 

cloud 
Installer 

Save Cloud Settings Permanently saves changes to the cloud parameters. 
Changes to the parameters are only adopted/used after 
saving. 

Installer 

Close Closes the Cloud tab Anyone & facility 
manager 

 

Table 32 Buttons in the Cloud view 

 

The Sign In and Upload Inspection Log buttons are only available when the cloud is activated.  

 

  



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 

Page 77  

8.15 “Distributor ” View 
 
You access the Distributor view by selecting the Distributor tab. The Distributor tab is only available at the distributor user level. 
In the Distributor view, the contact details and logo of the distributor are entered and other settings affecting the entire system 
are configured. Figure 84 shows a screenshot of the Distributor view. 
 
Table 33 lists the boxes in the Distributor view and their meanings. 
 

Box Meaning 
Company, Contact per-
son, Phone, Email 

Distributor’s contact details. These contact details are displayed in the Maintenance Due re-
minder window. 

Logo Logo, which is displayed in the WirelessProfessional software between the menu bar and Gen-
eral, Alarm list etc. tabs. If the distributor does not load his or her individual logo, the Wireless-
Professional logo is displayed. Figure 84 shows the Distributor view along with the distributor’s 
logo. Pressing the Search button opens a window for selecting the logo file from within the direc-
tory structure. The logo is only adopted in the display once the Save System Data button has been 
clicked on. The Reset button resets the logo to the WirelessProfessional logo. 

Maintenance notification The WirelessProfessional software displays maintenance notifications at the times defined by the 
maintenance interval. The Maintenance view can only be called up via the Help menu if Mainte-
nance notification is selected. 

Next maintenance Time at which the WirelessProfessional software displays the reminder window for the system 
maintenance due. Once maintenance has been completed, the date for the next maintenance is 
increased according to the maintenance interval. 

Maintenance interval Time between completed maintenance and the next maintenance notification. 
Maintenance password 
protected 

Password that has to be entered in the Maintenance view in order to be able to complete the 
maintenance. The maintenance password is generated automatically by the WirelessProfessional 
software from the address of the USB coordinator and cannot be chosen by the user. 

Maintenance plan 1-3 File paths to the maintenance plans and texts of links to the maintenance plans in the  
Maintenance view 

Send maintenance 
emails 

If the checkbox is ticked, sends emails containing a reminder that the maintenance date is due. 

Reduce capacity test du-
ration 

The time over which the capacity test is run can be reduced here from the full measurement period 
to 2/3 of the measurement period. 

Error Reset Activating this function permits the corresponding user level to reset error messages that are is-
sued by the WirelessProfessional system. 

 
Table 33: Boxes in Distributor view 
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The functions listed in  
Table 34 can be performed using the buttons in the Distributor view. 
 

Button Function User level 
Acknowledge Tests Removes all entries of failed test results (capacity test, function test) from 

the Alarm List view. The failed test results are not removed from the test 
run progress and the fact that the Acknowledge Tests function has been 
run is entered in the test run progress. Should there be emergency lumi-
naires with a failed test result, the test in question assumes an orange col-
our symbol in the device details window for the emergency luminaire and 
the error is displayed as "acknowledged" when the cursor is held over the 
colour symbol. 
The Acknowledge Tests function serves to allow the distributor to exit the 
customer’s system without error messages if errors have arisen during a 
capacity test and the errors have been remedied but the emergency lumi-
naires need charging for 20 h before the next capacity test. 

Distributor 

Reset Invalid  
Devices 

Registers the firmware of invalid devices in the system. The Invalid device 
error message may appear if the firmware of a device already installed in 
the system is being updated. 

Distributor 

Change Distributor Pass-
word 

Change the distributor password Distributor 

Reset Installer  
Password 

Reset the installer password to 2222 Distributor 

Save System Data Saves changes to the system Distributor 
 
Table 34: Functions of the Distributor view 
  

Figure 84: Distributor view, distributor user level 
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8.16 “Maintenance ” View 
 
The Maintenance view can only be reached via the Help menu or the maintenance notification. The Maintenance entry in the Help 

menu is only enabled if the distributor has activated the maintenance function. The Maintenance view can be seen at all user levels. Figure 85 
shows a screenshot of the Maintenance view. 
 

 

 

 
 
Click or tap on the Maintenance plan in English link to open the corresponding maintenance plan. The maintenance plan 
contains detailed instructions about how to maintain the system. 
One element of maintenance is checking that the relays of the IO boxes are fully functional. The system’s IO boxes are listed in the 
IO Boxes area. Double-clicking or tapping twice on the entry for an IO box in the IO Boxes area opens the device details window 
for this IO box. The relays can be switched over for the check using the  T  buttons in the Configuration view (also refer to Section 
8.17.3). 
Selecting the Confirm Maintenance button ends the maintenance, closes the maintenance window and increases the timer for 
maintenance to the next maintenance date. In some circumstances, the Confirm Maintenance button is password protected. On 
the left-hand side of the Maintenance view, enter the maintenance password before ending maintenance with Confirm Maintenance. 
  

Figure 85: Maintenance view, facility manager, installer or distributor user level 
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8.17 Device Details Window 
 
Click or tap twice on a device entry in the Alarm List, Groups or Configure Groups views to open the device details window 
for the device. This window differs depending on the device type. 
The device details window can be opened at all user levels. However, the entries can only be edited at Installer user level. 
 
 

8.17.1 Device Details Window for Emergency Luminaire 
 
The device details window for emergency luminaires allows the name/mounting location of the emergency luminaire to be entered 
and the operating mode to be switched between non-maintained and maintained operation. The position of the emergency lumi-
naire on the map, its address and the results of the last three tests are displayed in the details window. If you hover the cursor 
above one of the colour symbols of the test results or tap on them, the time of the test and the result are displayed in plain text. 
 
The luminaire transfers the time of the last reset to the control centre. A reset happens when the power supply fails (excessive 
discharge). 
 
The Information tab contains not only information about the set operating mode and set duration for tests but also information 
about the up time. The up time indicates the time since the last power supply failure or luminaire reset. A capacity test is only 
carried out after an up time of more than 20 hours. 
 

 
Figure 86 Device details window for emergency luminaire General tab 

 

 
Figure 87 Device details window for emergency luminaire Information tab 
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Device type Function 
Maintained Luminaire Luminaire for continuous lighting and for instances when the power supply to the 

general-purpose lighting fails 
Non-maintained Luminaire Luminaire for instances when the power supply to the general-purpose lighting 

fails 
 
 
8.17.2 Device Details Window for Repeaters 
 
In the Device Details window for repeaters, you can set the name/mounting location of the repeater and display its position on 
the map as well as its address. 
 

 

 
 
 
  

Figure 88: Device details window for emergency luminaire operating mode 

 

Figure 89: Device details window for repeaters 
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8.17.3 Device Details Window for IO Boxes 
 
In the General view in the Device Details window for IO boxes, you can set the name/mounting location of the IO box and display 
its position on the map as well as its address. The current status of the mains voltage at the IO box, the switching status of the 
three outputs (K1-K3) and two inputs (E1, E2) can also be shown using the same colours as the displays on the IO box. 
 

 

 
  

Figure 90: Device Details window for IO boxes, General view 
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The IO box’s inputs and outputs can be configured in the Configuration view of the Device Details window for IO boxes. 
 

 

 
 
 
In the Configuration view, select the K2 or K3 buttons to configure outputs 2 or 3 on the IO box. Figure 92 shows the window 
for configuring the outputs. The event, which is to trigger the output switching, is selected in the Output State area.  
Table 35 explains the meanings of the events listed. In the Groups applying area, you can select the groups in which the selected 
event has to occur in order for the output to be switched. If Energy Save / Activate, Manual Fire Alarm Active or Disabled 
is selected as the event, the groups selection is disabled because these events always affect the entire system. 
 
 

 

 
  

Figure 91: Device Details window for IO boxes, Configuration view 

 

Figure 92: Configuring the IO box output 
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Event Function 
Test Running Output is switched for the duration of the test 
Last Test Failed Output is switched as a result of a failed test 
Maintained Luminaires switched Output is switched if at least one maintained emergency lumi-

naire is switched off 
Non-Maintained Luminaires switched Output is switched if at least one non-maintained emergency 

luminaire is switched on 
Luminaires Blocked Output is switched if at least one emergency luminaire is in re-

mote inhibiting mode 
Energy Save / Activate Output is switched if all switchable emergency luminaires are 

switched off 
Manual Fire Alarm Active Output is switched if the signal at the fire alarm input on the IO 

box is enabled 
Disabled Output is disabled 

 
Table 35: Output states of outputs 
 
Output 1 (K1) is always allocated the Event Device Error function and cannot be configured. The relay of output 1 de-energises 
as soon as a device in the system reports an error. The relay of output 1 will only de-energise with the time to connection error 
for IO boxes delay if the radio connection between the IO box and automatic test system is interrupted. The time to connec-
tion error for IO boxes duration is set in the Installation/System view (Section 8.12.5). 
The function of the output relays can be checked by pressing the  T  buttons in the Configuration view. The  T  buttons switch 
over the relay of the respective output. As soon as the Configuration view is exited, the relays of outputs K1-K3 are reset to the 
switching state, which matches the configuration of the respective output. 
In the Configuration view, select either the E1 or E2 button to configure the inputs on the IO box. Figure 93 shows the window 
for configuring the IO box inputs. A name can be assigned in the Input Name area. The process which is triggered by the signal 
at the input is selected in the Operating Mode area.  
Table 36 explains the operating modes of the inputs. In the Logic level area, select whether the event is triggered by a high level 
(high-active) or by a low level (low-active) at the input. The groups affected by the process are selected in the Groups to switch 
area. If Energy Save / Activate, Manual Fire Alarm Active or Disabled has been selected as the process, the groups 
selection is disabled because these events always affect the entire system.  
 
 

 

 
  

Figure 93: Configuring the IO box input 
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Operating mode Function 
Switch Maintained Luminaires Switches maintained emergency luminaires on/off 
Switch Non-Maintained Luminaires Switches non-maintained emergency luminaires on/off 
Start Function Test Starts a function test (only action switch) 
Block Luminaires Puts emergency luminaires into remote inhibiting mode 
Energy Save / Activate Switches all switchable emergency luminaires off / 

switches all maintained emergency luminaires on 
Manual Fire Alarm Active Switches all switchable emergency luminaires on 
Reset Fire Alarm Overrun Time Ends the overrun time after a fire alarm. 

(only action switch) 
Emergency mode 1h Switches selected groups into emergency mode for 1 

hour (not available in all regions) 
Disabled Disables this input 

 
Table 36: Operating modes of IO box inputs 
 
 

8.18 Menus 
 
The menu bar is located under the title bar of the WirelessProfessional software window. The menu bar is not displayed in 
full-screen mode! You can use the Alt + Enter key combination to switch between full-screen mode and the normal viewing 
mode.  
A password has to be entered to exit full-screen mode. Once full-screen mode has been exited, login at the user level matching the 
password is activated. 
 
 

8.18.1 File Menu 
 
Figure 94 shows a screenshot with the File menu expanded.  
Table 37 explains the entries in the File menu. The Inspection Log, Communications Log and System Log menu functions 
correspond to those in the Alarm List view. 
 

 

 
 
 
 
 

Figure 94: File Menu 
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Menu entry Function 
Inspection Log Opens the test run process. See Section 0 Eine Funktions- oder Dauerprüfung kann nur dann ge-

startet werden, wenn die Batterien der Notleuchten ausreichend geladen sind (siehe Abschnitte 2.2 
und 2.3). 
Prüfverlauf 

Operationtime Log Not implemented 
Communications Log Opens the communications log. See Section 5.7.2 Kommunikationslog 
System Log Opens the system log. See Section 5.7.3 Systemlog 
Quit Application Closes the WirelessProfessional software 

 
Table 37: File menu 
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8.18.2 Options Menu 
 
Figure 95 shows a screenshot with the Options menu expanded. Table 38 explains the entries in the Options menu. 

 

 

 
 

Menu entry Function User level 
Serial Port Manual selection of port for USB coordinator Anyone 
Start Function Test Starts a function test for all emergency luminaires Facility manager, installer 
Start Capacity Test Starts a capacity test for all emergency luminaires Facility manager, installer 
Put Message into Inspection 
Log 

Manual input of messages into test run progress Anyone 

Login / Logout Login / Logout as facility manager or installer - 
Toggle Fullscreen Toggles into full-screen mode Anyone (enable) 

 
Table 38: Options menu 
 
A function or capacity test can only be started if the batteries of the emergency luminaires are adequately charged (see Sections 
2.2 and 2.3). 
 
 
  

Figure 95: Options menu 
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8.18.3 Help Menu 
 
Figure 96 shows a screenshot with the Help menu expanded. Tabelle 34 explains the entries in the Help menu. 
 

Menu entry Function 
Contact Shows the installer’s contact details. 
Show Support Infor-
mation 

Shows the device address of the USB coordinator (device number), the date on which the 
WirelessProfessional software version was created (build date) and the contact details of the 
installer and distributor (Figure 97) 

Perform Maintenance Opens the Maintenance view. The Maintenance entry is only enabled if the distributor 
has activated the maintenance function 

Software Update WirelessProfessional can be updated as of version 2.1. A corresponding update file can be 
selected and loaded onto the system in the Software Update view. 

Toggle Fullscreen Software is switched to full-screen mode. 
About… Shows the software version, build date and manufacturer 

 
Table 39: Help menu 
 

 

 
 
There are two ways of accessing the Help menu. Firstly, using the top task bar and secondly on the right-hand side using the button 
in the banner. There is however one difference between them. If you access via the button in the banner, the software can be 
switched to full-screen mode but this option is not available under Help accessed using the top task bar. 
 

Figure 96: Help menu 
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Figure 97: Support information window 
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9 Other Software 
 
WirelessProfessional systems are supplied with additional programs pre-installed and configured. Consult the user manual of the 
respective hardware for details.  
The WirelessProfessional setup for Windows is supplied with installers for the additional program or the additional program as a 
portable version (in the most recent version at the time of release). These are also stored in the WirelessProfessional folder. Table 
40 provides an overview of the help programs provided. 
A licence is needed to be able to use the software in some cases. 
 

Software Function Licence 
VNC server Remote desktop software for connections in the local 

network. 
Download the client (VNC viewer) from 
https://www.realvnc.com/download/ 

Server: licence needed, www.realvnc.com 
Client: no licence needed 

TeamViewer 
portable 

Remote desktop software for connections via the In-
ternet. 
Download the client (TeamViewer All-in-one) from 
http://www.teamviewer.com/de/download/index.aspx 

Server(host): no licence needed 
Client: licence needed, 
https://www.teamviewer.com/de/licensing/in-
dex.aspx 

RustDesk4 Remote desktop software for connections via the In-
ternet. 

No licence needed  

   
Table 40: Other pre-installed software 
 
 
 
  

 

4 A private relay server based in Europe is run for remote access to WirelessProfessional products. The server ID has to be maintained 
manually 
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10 IP Address 
 
For the Wireless Professional software to be able to monitor another device via Ethernet, there must be a network connection 
between the devices. 
 
Admin rights are needed in the device to set up the network adapter properties. If you do not have these rights, please contact 
your administrator or distributor. 
 
If the monitoring device is not in the same IP address space as the monitored device, an appropriate route must be created from 
one IP address space via a gate to the other address space. 
 
The network route is set up in the operating system. Contact your administrator. 
 
A device requiring monitoring can be addressed by the Wireless Professional software both using the DNS and the IP address. For 
the device to be addressed via DNS, the name server must be entered during network configuration.  
 
The DNS is set up in the operating system. Contact your administrator. 
 



 
 
 
 
 
 

WirelessProfessional 
 Installation and Software Operation 
Page 92  

11 Problem-Solving 
11.1 During the Installation, a Device Address is Not Shown in the Unknown Nodes Area 
 
Check the following in the order stated: 
1. Check that the device is connected to the mains voltage (emergency luminaires: Is the charge check indicator lit up? IO box: Is 

the green indicator lit up?) 

2. If the device is connected to the mains voltage: Go to 2 
3. If the device is not connected to the mains voltage: Connect the device to the mains voltage. 
4. Check whether the device is transmitting a radio signal. Run the USB coordinator with the PC and WirelessProfessional soft-

ware next to the device. Check whether the device address is displayed in the Network Information view. 
5. If the device address is displayed in the Network Information: Go to 3. 
6. If the device address is not displayed in the Network Information: Contact our distributor. 
7. Check whether the device address is listed under Unknown nodes when you run the USB coordinator with the PC and 

WirelessProfessional software next to the device. 
8. If the device address is listed under Unknown nodes: the radio connection to this device is presumably interrupted because 

the distance between the devices is too great at one or more points in the radio network. 
9. If the device address is not listed under Unknown nodes, the device has not been correctly registered in this system. To 

correct this, manually create the luminaire and assign it to the system. Then delete the luminaire again from the system and 
also from the list of Unknown nodes. The luminaire should now automatically appear under Unknown nodes.  
 
 

11.2 Invalid Devices are Displayed in the Unknown Nodes Area 
 
The WirelessProfessional software reports invalid devices if the device firmware is not saved in the WirelessProfessional software. 
This typically happens when new devices produced at a later date are added to an existing WirelessProfessional system. To update 
the WirelessProfessional software, contact our distributor. 
 
 

11.3 After the WirelessProfessional Software is Launched, System Remains in Status is being up-
dated Operating Status 

 
The time for which the automatic test system remains in the Status is being updated operating status (colour symbol ) after 
a reboot is set by the longer of the two Time to connection error and Time to connection error for IO boxes times. The 
Time to connection error and Time to connection error for IO boxes values can be set in the System view (see Section 
5.11.4). 
 
 

11.4 Forgotten Facility Manager Password 
 
The facility manager password can be reset to 1111 by the installer or our distributor. The facility manager password is reset in the  
Installation/System view. 
 
 

11.5 Forgotten Installer Password 
 
The installer password can be reset to 2222 by our distributor. 
 

11.6 Luminaire Not Sending Connection Requests / Not Appearing in Unknown Nodes Area 
 
Devices which are not automatically detected by the system can be manually added by the user (see Figure 66 onwards).  
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11.7 Changing USB Coordinator 
 

1. Disconnect USB coordinator from PC by removing USB coordinator from USB cable. 
2. In the software, go to Installation → System and press the Reconnect All Devices button (see Figure 79). 
3. Close the software. In the top left of the software under File, go to Quit Application and confirm the following mes-

sage with OK (The USB cache is deleted). 
4. Relaunch the software. 
5. Connect the new USB coordinator with the PC. 
6. Then establish a connection in the software by selecting the serial port (see Section 3.3). 
 
Note: Once the connection to the coordinator has been established, the Wireless Professional software will automatically under-
take re-association of all devices by individually disassociating the devices in turn and then re-associating them. 
 

11.8 Reading the Version and Build Platform of the WirelessProfessional Software 
 
The build platform is entered in every log file (inspection log, communication log and system log) when the WirelessProfessional 
software is launched. This information can also be found in the About window in the Help menu. 
 

 

 
Figure 98 About Window 
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12 Technical Data 
 
Table 41: Technical data* 

  
Operating frequency 865MHz – 868.6MHz 
Tuning range 868MHz +/- 100kHz 
Type of modulation GFSK 
Name of transmission F2DCT (1% duty cycle) 
HF channel division 868MHz +/- 50kHz 
Transmission bandwidth 300 kHz 
Transmission power maximum 
  effective 

10dBm (10mW) 
-10dBm (0.1mW) 

Indoor range Min. 30m (for luminaires with plastic casing, repeaters and IO boxes) 
Min. 24m (for luminaires with metal casing) 

 
*For relevant standards and specifications, refer to declaration of conformity 
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13 Glossary 
 
Automatic test system (ATS) 
Automated test system, which may be triggered by hand, comprising parts (such as internal clock, current detectors, light detectors, 
selector switches) which are connected together to form a system. This system can perform the routine requirements of tests on 
emergency luminaires and display the test results (EN 62034:2012) 
Autonomy time 
In the WirelessProfessional software, the term used for the rated operating period. 
Battery mode 
Status of an emergency luminaire with individual battery, which ensures lighting by supplying power from its in-built current source 
should the general power supply fail (EN 60598-2-22:1998 + A1:2003) 
Rated operating period 
Period stated by the manufacturer [of emergency luminaires] for which the rated light current is output (EN 60598-2-22:1998 + 
A1:2003). Known in the WirelessProfessional software as “autonomy time”. 
Rated light current of the emergency luminaire 
The light current, which according to the manufacturer is output within 60 s (0.5 s for workplaces subject to particular hazards) 
after a fault to the general power supply and is output from then until the end of the rated operating period (EN 60598-2-22:1998 
+ A1:2003) 
Fire alarm input 
Option for configuring the inputs of an IO box. If the signal at a fire alarm input is enabled, all switchable emergency luminaires are 
switched on. If the fire alarm signal is switched off, the emergency luminaires remain switched on for the duration of the fire alarm 
overrun time and only then are they switched off again. 
Fire alarm overrun time 
Time during which the emergency luminaires remain switched on once the signal at the fire alarm input is no longer enabled. 
Capacity test 
Test for whether the battery of the safety lighting system is supplying the system in line with the limit values for the rated duration 
of emergency mode (EN 62034:2012) 
Directly addressable IoT device 
Directly addressable IoT devices are usually connected to the LAN using their own IP address or have their own direct network 
connection, e.g. by means of a mobile service, and can act independently or are managed by a central control unit. (SYS.4.4 general 
IoT device) 
Remote inhibiting mode 
Status of an emergency luminaire with individual battery which is taken out of operation by a remote control unit when the general 
power supply is present and the luminaire does not switch to battery mode when the general power supply fails. (EN 60598-2-
22:1998 + A1:2003) Remote inhibiting mode is only permitted during idle times in operation. Only switchable emergency luminaires 
can be run in remote inhibiting mode. If the emergency luminaire loses radio contact with the automatic test system, remote 
inhibiting mode is ended after 15 minutes. Emergency luminaires in remote inhibiting operation cannot be tested and remain in 
remote inhibiting mode even in the event of a fire alarm. 
Function test 
Test to establish that the circuit is intact and that a lamp, changeover device and energy source are running as intended (EN 
62034:2012) 
Device address 
4-digit Base32-coded address, with which a device identifies itself within the wireless system.  
Masking 
A function of the WirelessProfessional software, which suppresses error messages from masked devices. Masked devices can be 
recognised as such in the Configure Groups view. 
Mains operation 
Status of an emergency luminaire with individual battery which is operational in emergency mode when the general power supply 
is present. In the event of a fault with the general power supply, the emergency luminaire with individual battery automatically 
switches into battery mode (EN 60598-2-22:1998 + A1:2003) 
Emergency lighting 
Lighting which takes effect when the power supply to the general-purpose lighting fails (CIE Publication 17.4, EN 60598-2-22:1998 
+ A1:2003) 
Non-maintained emergency luminaire 
Luminaire in which the lamps for emergency lighting are only switched on when the power supply to the general-purpose lighting 
fails (EN 60598-2-22:1998 + A1:2003) 
Maintained emergency luminaire 
Luminaire in which the lamps for emergency lighting are always continuously powered when general-purpose lighting or emer-
gency lighting is needed (EN 60598-2-22:1998 + A1:2003) 
Emergency luminaire with individual battery 
Maintained or non-maintained luminaire for emergency lighting, containing all parts, such as battery, lamp, control unit and test 
and monitoring equipment, if provided. These parts are located in the luminaire or in its direct vicinity (i.e. within a cable length of 
1 m) (EN 60598-2-22:1998 + A1:2003) 
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Fault to the general power supply  
Status in which the general-purpose lighting is no longer able to guarantee the minimum light level over the escape routes and in 
which emergency lighting is to start up (EN 60598-2-22:1998 + A1:2003) 
System ID 
An ID for the wireless network, which is derived from the coordinator’s wireless address and is transferred to all devices in a sys-
tem.  
WirelessProfessional control centre 
A unit comprising a PC with WirelessProfessional software and coordinator is known as a control centre. 
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14 Revision History 
 

WirelessProfessional – Installation and Software Operation 
Date Software version / Revision Comments / Important changes compared to the previous version 
09.07.2014 1.2.0 Creation 
24.09.2015 1.3.0 Update. "Maintenance" and "Other Software" sections added. 
13.07.2017 1.4.0 Updates to WirelessProfessional 
10.11.2017 1.4.1 Corrections 
14.11.2017 1.4.2 Corrections 
16.11.2017 1.4.3 Corrections 
23.11.2017 1.4.4 Coordinator changes added 
01.02.2018 1.4.5 Corrections 
19.06.2018 1.4.6 Remote facilities added 
21.08.2019 1.4.7 WL Pro Version 2.2, font, “Technical Data” section added 
16.09.2019 1.4.8 Changes to fire alarm overrun time in Table 10 
07.10.2020 1.4.9 Updates for WL Pro version 2.3 
xx.12.2022 1.5 Updates for WL Pro version 2.4 
02.05.2024 1.7 Changes for WL Pro version 2.4.8 
20.09.2024 1.8 Updates for WL Pro version 3.0 
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15 List of Key Words 

Activate  38, 42 
Address  7 
Alarm list, view  43 
Automatic test  24 
Automatic test system  95 
Battery error  40 
Battery mode  95 
Block emergency luminaires  42 
Capacity test  8, 24, 25, 42, 48, 60, 95 
Capacity test, configuration of  60 
Change distributor password  78 
Change installer password  69 
Communications log  45 
Configure groups, view  54 
Connection error  40 
Connection lost  40 
Device  7 
Device details  80 
Device types  7 
Distributor, view  74, 77 
Email, view  52 
Emergency lighting  95 
Emergency luminaire with individual battery  95 
Emergency luminaire, device details  80 
Emergency mode  7 
Energy save  38 
Energy Save  42 
Event device error  84 
Failure of the power supply  7 
Fault to the general power supply  96 
Fire alarm  38 
Fire alarm input  95 
Fire alarm overrun time  42, 95 
Full-screen mode  87 
Function test  24, 42, 48, 60, 95 
Function test, configuration of  60 
Groups  47 
Illuminant error  40 
Installation  9 
Installation, view  54 
Installer password  11, 35 
Installer, contact details  68 

Installing devices  12, 57 
Installing devices manually  58 
Invalid device  40 
IO box  7 
IO box, device details  82 
Mains operation  95 
Maintained emergency luminaire  7, 95 
Maintenance  79, 88 
Map  18 
Maps, view  49 
Masking  95 
Network Information, view  71 
Non-maintained emergency luminaire  7, 95 
Processor-controlled emergency luminaire  8 
Quit application  86 
Rated light current  95 
Rated operating period  95 
Remote inhibiting mode  38, 48, 95 
Repeater  7 
Repeater, device details  81 
Reset facility manager password  69 
Reset installer password  78 
Reset invalid devices  78 
Send/receive radius  6 
Software Installation  26 
Status symbols  38 
Support information  88 
Switching emergency luminaires  48 
Symbols  38 
System log  46 
System requirements  26 
System, view  68, 69 
Tab  1 
Test run progress  44 
Test, view  60 
Time to connection error  68 
Timer, view  61 
Unknown node  57 
USB coordinator  6 
View  1 
WirelessControl system  6 
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16 Contact Information 
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